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Introduction

In any language, parts of speech are the categories of words based
on their function within a sentence. These are the ‘building blocks’
of a language.

When we speak or write, we use sentences to express ourselves.
Therefore, sentences are important.

A ‘sentence’ is a group of words that communicates a complete
meaning, thought or action. For example, Raju goes to school.

A group of words, which does not make complete sense, is known
as a ‘phrase’, for example, Raju goes.

A sentence always begins with a capital letter, and ends with a full
stop, question mark or exclamation mark. Read aloud the examples
given below.

e Did you work on your project?
e I completed it yesterday.
e That is good!

Using capitals

We know that all sentences begin with a capital letter. It is easy to
know what to capitalise if you remember the acronym ‘MINTS'.
MINTS is a set of simple rules that help you to capitalise words
correctly. Each letter in the word MINTS refers to one capitalisation
rule as shown in Table 1.3.

Table 1.3: Capitalisation rules

Alphabet | M I N T S
Months I Names Titles Starting letter
of sentences
Rule Capitalise Capitalise Capitalise the Capitalise | Capitalise the
the first the letter first letter in the | the first letter in
letter in ‘I when names of | first letter | every
the names used as a people, in sentence.
of all word. places, rivers, the titles
months. seas and | used
oceans, before
mountains, people’s
islands and | names.
days.
Example | I will go to Every This Tuesday, Dr Shah | The cat ran
college in day, I play Vidya is in and out of the
June. tennis Rajasthan. Mr Patel | house.
with him. work
together.
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Punctuation
There are 15 basic punctuation marks or signs used in English.
These include full stop or period, comma, question mark,
exclamation mark, apostrophe, colon, semi colon, dash, hyphen,
parenthesis, quotation mark, bracket, brace, ellipsis and bullet
point (Table 1.4).

Table 1.4: Punctuation marks

\~7

by an 's° to show that
something belongs to someone.

Punctuation Sign | Use Example
mark
Full stop It shows the end of a sentence. | This is a sentence. This is
It is also used to show short | another sentence.
form of long words. For | Sanjay is a Professor.
example, ‘Professor’ can be | His patients call him
shortened as Prof., when used | Prof. Sanjay.
as a title before a name.
Comma o Sometimes, we use comma to | After the waiter gave me
indicate pause in a sentence. the menu, I ordered food.
We can also use comma to | I bought apples, oranges
separate items when we are | and grapes.
listing more than two items in a
row.
Question ? We use question mark at the | What is your designation?
Mark end of a question. How much is your work
experience?
Exclamation ! We use an exclamation mark at | What a pleasant surprise!
Mark the end of a word or sentence | You are late!
to indicate a strong feeling,
such as surprise, shock or
anger.
Apostrophe (') | We use an apostrophe followed | That is Divya’s desk.

Are these Abdul’s books?

We also use an apostrophe to
indicate the shortened form of
some words in informal speech.

Let’s go instead of Let us
go!

He isn’t here instead of
He is not here.

Basic parts of speech

The different types of words we use in sentences are called
parts of speech. The basic parts of speech are nouns,

pronouns, adjectives, verbs and adverbs (Table 1.5).

Figure 1.3: Basic parts of

speech

10
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Table 1.5: Basic parts of speech

Parts of | What they do Example sentence Example
speech words
Noun Nouns are words that refer to In the sentence: "“Reema | Dog
a person, place, thing or idea. | wrote a letter.” Both Reema | India
They are ‘naming words’. and letter are nouns. Sanjay
Pronoun A pronoun is a word used in In the second sentence: | They
place of a noun. “Reema wrote a letter. She is | He
tired.” She is used in place of | You
the noun Reema. It is a
pronoun.
Adjective | Adjective is a word that In the sentence: "“Reema | Small
describes other words. wrote a long letter.” Long is | Blue
an adjective that describes the | Sharp
noun ‘letter’. Loud
Verb Verb is a word that shows In the sentence: "“Reema | Run
action. wrote a letter.” Wrote is a | Eat
verb. It tells what action | Think
Reema did. Sit
Adverb Adverb is a word that adds In the sentence: "Reema Easily
meaning to a verb, adjective, quickly  wrote a letter.” | Always
or other adverb. It answers Quickly is an adverb. It tells | Inside
the questions — how? how us how Reema did the action | Before
often? when? and where? (writing).

Sometimes, the same words can be used differently.

Will you book a movie for 3 pm?

adverb.

‘Book’ is used as an

I need to find my English book.

‘Book’ is a noun.

His total cricket score was 145.

‘Total’ is an adjective.

That is totally awesome.

‘Totally’ is an adverb.

She is always watching a football match.

‘Football’ is an
adjective.

She got a new football for her birthday.

‘Football’ is a noun.

The experienced sailor was able to hold up the
sail despite heavy storm.

*Sail” is a noun.

Satish was able to sail through despite the storm.

‘Sail’ is a verb.

Kapil promised his father that he will be a good boy.

‘Promised’ is a verb.

Kapil was unable to keep the promise given to his father.

‘Promise’ is a noun.

AR DI
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Let us now see how these words are used. Read out aloud the sentence
given below.

Wow! Reema went to the studio and met a famous actor. We already
know that Reema, studio and actor are nouns. Famous is an adjective
because it describes the actor (noun) and the words went and met are
verbs because they describe an action.

What about the remaining words in this sentence — wow, to, the, and?
What are these words called? We use such supporting words to join the
main parts of speech together and to add information to the sentences that
we frame. Let us now look at supporting parts of speech.

On
. |m ‘.!I LU or
|

>

Conjunctions Prepaositions Interjections

Supporting
parts of
speech
Articles

12

Figure 1.4: Supporting parts of speech
Supporting parts of speech
Along with the main ‘Parts of Speech’, there are some more words we need
for connecting words, phrases, clauses or sentences. Such words are called
‘supporting parts of speech’. (Figure 1.4 and Table 1.6).
Table 1.6: Supporting parts of speech

Use Example

e The words ‘a’, ‘an’ and ‘the’ are The car stopped suddenly because

known as articles. a cat ran in front of it.
e Articles are, generally, wused A book

before nouns. An apple
e ‘An’ is used before words with a An umbrella

vowel (a, e, i, 0, u) sound. The sun

e ‘A’ is used before nouns starting
with a consonant (all except those
starting with a, e, i, o and u)
sound.

e 'The’ is used to refer to specific
or particular words.
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Conjunctions  Conjunctions are words that join two Instead of - Sheela went to the
nouns, phrases or sentences. market. I went to the market.
Sheela and I went to the market.
Some common conjunctions are ‘and’, Instead of - Do you want oranges?
‘or’ and ‘but’. Do you want apples?
Do you want oranges or apples?

Prepositions e Prepositions connect one word The catis on the roof.
with another to show the The shop is at the end of the road.
relationship between them. They, Rahul is standing under the tree.
usually, answer the questions I live in Delhi.
‘where’, ‘when’ and ‘how’.
e Some common prepositions are
‘on’, ‘at’, ‘under’ and ‘in’.

Interjections  These words express strong Wow!
emotions, such as happiness, Oh!
surprise, anger or pain. They have an Oh no!
exclamation mark at the end. Thanks!

Help!

The teacher will facilitate these activities by showing you the e-
learning lesson at http://www.psscive.ac.in/Employability
Skills.html. This will include videos and e-content for the above
topics, as well as, detailed instructions for the following activities.

Initial thinking activity
After watching the initial video in the e-learning lesson for this topic,
write down what do you think was wrong with Seema’s letter.

Group practice
Identifying ‘parts of speech’

Material required
Notebook, pen, etc.

Procedure
e Form groups of four students each. Read aloud the paragraph
given below.

“on sunday, i have an appointment to meet dr. patel in delhi.
my house is near dr. patels clinic i went to a shop near the clinic
on friday to buy vegetables I bought potatoes onions carrots
and a cabbage dr. patel is a friendly man have you met him”

e This paragraph contains examples of parts of speech that you
have learnt about in this Session. Identify as many parts of
speech as you can and mark them. Discuss what was difficult in
this activity. Write the paragraph with correct capitalisation and
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Notes punctuation. A member of one group volunteers and presents before the

class what the group marked. The person writes the paragraph on the
classroom board with the punctuations. The other students point out the
mistakes, if any.

Activity 2

Group practice
Constructing sentences

Material required
Notebook, pen, etc.

Procedure

e Form pairs of students.

e List the five basic parts of speech that you have learnt in this
Session.

e Select one of them and form two simple sentences, which use these
parts of speech. For example, if you have chosen adjectives, form
two sentences that have adjectives. For each part of speech, a
volunteer reads out the sentences the group has framed.

e The other students say if it is correct or not.

A. Multiple choice questions
Read carefully the questions given below and choose the correct option.

1. What is a sentence?

(@) A group of ideas that form a complete paragraph

(b) A group of words that communicates a complete thought
(c) A set of rules that we must follow to write correctly

(d) A set of words that contains basic punctuation marks

2. Which of these sentences is capitalised correctly?

(a) I am Hungry.

(b) Divya and sunil are reading.
(c) The bucket is Full of water.
(d) She lives in Delhi.

3. Which of these sentences is punctuated correctly?

(a) Where are you going.

(b) I have a pen a notebook and a pencil.
(c) I am so happy to see you!

(d) This is my house.
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B. Fill in the blanks

1. Fill in the correct nouns and verbs as given at the top of the
table to complete the following sentences.

Nouns Verbs
girl, girls, boy, milk, dog, | skipping, riding, running,
student studying, drinking, barking
™ (a) The is
ﬂ ]
-
" i i (b) The are
By (c) The is
O
~y (d) Raju is
| _
- (e) The is
¥
¢{_, (f) The is
C. Short answer question
1. Identify  conjunctions and prepositions  (remember,

conjunctions join two sentences, while prepositions help
answer the words ‘where’, ‘when’ and ‘how’) from the list
given below and write them in the following columns.

Under, and, in, at, or, up

Conjunctions

Prepositions

AR DI
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Notes

After completing this Session, you will be able to:

e identify the basic parts of speech, such as nouns,
pronouns, adjectives, verbs and adverbs.

e use capitalisation and punctuation rules for sentences.

e explain the usage of parts of speech and identify them in
a sentence.

e identify supporting parts of speech, such as articles,
conjunctions, prepositions and interjections.

Introduction

A sentence is a group of words, which together expresses a complete
idea that has meaning. A sentence is formed by putting together a
group of words in sequence. This means that a sentence must be
understood by others.

A sentence, typically, contains a subject and an object, conveying a
statement, question, exclamation, or command. Writing is constructed
by putting sentences in sequence so that they are understandable.

Simple sentence

A simple sentence is one that has only one subject and one predicate or
has only one finite verb.

Complex sentence
A complex sentence is one, which consists of two or more coordinate
clauses, joined by a coordinating conjunction.

As you have studied in English classes, almost all sentences have a
subject and a verb. Some also have an object.

e A subject is a person or thing that does an action.
Verb describes the action.
Object is the person or thing that receives the action. For example,
read aloud the simple sentence — “Nisha sells a laptop”. Let us see
the different parts of the sentence in Figure 1.5.
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A subject is a
person or thing
that performs an

action. The
question,

“who performed
the

action?” will help
you

find the subject.
In

this sentence,
*Nisha’

is the subject.

Nisha

Sells

a Laptop

Verb describes the action. The object.
question, “what is the action?” will
help you find the verb.

sentence, ‘sells’ is the verb.

In this

An object is the
person or thing
that

receives the
action.

The question,
“who

received the
action?”

will help you find
the object. In this
sentence, ‘a
laptop” is the
object.

Figure 1.5: Parts of a sentence

Read aloud the sentences given in Table 1.7 to understand about subject,

verb and object.

Sentence

I wrote a letter.

Table 1.7: Parts of a sentence

He called the customer.
She packed the product.
Dia and Sanjay booked a cab.

Subject
I

He

She

Dia and
Sanjay

Verb
wrote
called
packed
booked

The object in a sentence can be either direct or indirect.
Direct objects are the ones directly ‘acted on’ by the action word (verb). If we
ask — “What does Nisha sell?”, the answer is ‘laptop’, which is direct object. A
direct object answers the question ‘what?’.

Object

a letter

The customer
the product

a cab

An indirect object answers the questions, such as “to whom” and “for whom”.

For example, in the sentence — “Abdul gave a gift to his mother.” The verb is
‘gave’. What did Abdul give? A gift. To whom did Abdul give the gift? To his
mother. Here, ‘gift’ is direct object and *his mother’ is indirect object.

Some sentences only have direct objects, while some have both direct and

indirect objects.

Read out aloud the examples given in Table 1.8.

AR DI
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Sentence

Reema
stationery.

Fatima and Sonia

played tennis.

He offered a coffee
to me.

The manager
assigned us projects.

e

Table 1.8: Direct and indirect objects

Verb Verb + Verb + by Direct Indirect
what? whom/to object object
whom?
bought bought stationery stationery
played tennis tennis
offered coffee me coffee me
assigned projects us projects us

Sanjay

lbr ok ! the glagg,
|

'I'Iu:glani was | broken JIIJ-T Sanjay.

Figure 1.6: Types of sentences

e e
Active ‘
E:’nn'm

Paccive

RArzmrme
1keaction

broke | the glaas

| T glass
L

T, 2
WEE | brouen | Dy SanjEy.

Figure 1.7: Active and passive sentences
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Types of sentences —

Category I

What is the difference between the following
two sentences?

1. Sanjay broke the glass.

2. The glass was broken by Sanjay.

The action (verb) in both them sentences is
breaking of the glass. But the ‘subject’ in both
the sentences is different. In the first
sentence, the subject (Sanjay) does the
action. In the second sentence, the subject
(the glass) receives the action.

Read the sentences in Figure. 1.7 again.

Sentences, where the subject does an action,
are known to be in active voice.

Sentences, in which the subject receives an
action, are known to be in passive voice.
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Table 1.9: Active and passive sentences

Active voice

She wrote an email.

He opened the door for the

customer.
Mohan sold a bike.

Passive voice

An email was written by her.

The door was opened by him

for the customer.

The bike was sold by Mohan.

Examples of active and passive sentences

Active
I did not beat him.

Kapil made a
yesterday.

Passive

He was not beaten by me.

profit A profit was made by Kapil
yesterday.

The tiger was chasing the The deer was being chased by

deer.

the tiger.

Types of sentences — Category II

There are mainly four types of sentences,

interrogative, exclamatory and imperative.
Each of these have been described in Table 1.10.

i.e., declarative,

Table 1.10: Types of sentences — Category 11

Statement or
declarative sentence

It provides information
or states a fact. It
always ends with a full
stop (.). This is the
most common type of
sentence.

Read aloud the examples given below.

I go to office.

It is very cold.

I completed
project.

my

AR DI

Question or
interrogative

sentence

This type of
sentence asks a
question. It
always ends
with a question
mark (?).

Did you go to
office?
How is the
weather?
Did
complete
your project?

you

Emotion, reaction or
exclamatory sentence

An exclamatory
sentence expresses a
strong emotion, such

as joy, sadness, fear or
wonder. It always ends
with an exclamation
mark ().

I received the prize for
the best employee!

Oh, it's very cold!

I completed my project!

Order or
imperative
sentence

These sentences
show an order,
command, request
or advice. It can
end with a full stop
or an exclamation
mark (. or !).

Go to office today.

Wear your
sweater.

Complete your
project.

19
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Examples of types of sentences — Category I1

Sentence Type
Where is my I-card? Interrogative
My arms ache from planting those saplings! Exclamatory

Reading mythology will make you more aware. Declarative

Come with us right now. Imperative
No way! I don’t want a tattoo! Exclamatory
Get out of the bed immediately Imperative
| —— | et
:.:'.:Il;l;:lr;-:mw Tl < ;-T;-:_r.':.l!ll::‘_:lll_l-.ﬁh‘_ >

— /",// —-‘--_5;:“'!-..
D & o
- R -e

m did radl

O [FTEE B ] Simlarmond R dc:Eidan T P

Figure 1.8: Types of sentences — Category II

You can see that each of these sentences have a different purpose.
Paragraph

A group of sentences forms a paragraph. While writing a paragraph,
make sure the sentences have a common idea. When you want to
write about a different idea, make a new paragraph. For example, if
you are writing about your school, the first paragraph can be of
sentences about the name, location, size and other such details. In
the next paragraph, you can use sentences to describe what you
like about your school.

I go to Government Higher Secondary School, Balachadi. It
is not a very big school but has many good teachers. There
are about 100 students in my school. My school is on the
main road, very close to the city railway station. I love going
to school and learning about new things. My school has a
small playground, where I play cricket with my friends after
the classes are over. It has a library also. I love my school.
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The teacher will facilitate these activities by showing you the e-learning
lesson at http://www.psscive.ac.in/Employability Skills.html. This will
include videos and e-content for the above topics, as well as, detailed
instructions for some activities given below.

Initial thinking activity
After watching the initial video in the e-learning lesson for this topic,
write if you think Sanjay and Dia were able to frame correct sentences.

Activity 1
Pair work
Making sentences

Material required
Notebook, pen, etc.

Procedure

e Form pairs of students.

e First, write three sentences having direct objects.

e Then, write three more sentences, containing both direct and
indirect objects.

e Use different colours to mark the different parts of each sentence
(subject, verb and object).

Activity 2
Pair work
Active and passive voice

Material required

Notebook, pen, etc.

Procedure

e With same pairs as above, write a paragraph on any topic. The
paragraph should have at least two sentences in active voice and
two in passive voice. One student reads out the paragraph that the
person has written before the class.

e The class gives the feedback.

Activity 3
Pair work
Types of sentences

Material required
Notebook, pen, etc.

Procedure

e With the same pairs as above, make a list of minimum eight
msentences. These should have at least two sentences of each
type: declarative, interrogative, exclamatory and imperative.

e For each type of sentence, different volunteers read out their
sentences before the class.

e The class, then, gives feedback on the correctness of the
sentences.

AR DI
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Notes

22

A. Multiple choice questions

1. Identify the subject in the sentence, “The children played football”.
(@) The children

(b) children played

(c) played

(d) football

2. Identify the object in the sentence, “The children played football.”
(@) The children

(b) children played

(c) played

(d) football

3. Which of these sentences has/have both indirect and direct objects?
(a) I am working on a presentation.

(b) She bought a blue pen.

(c) The girls played cricket.

(d) He wrote a letter to his sister.

4. Which of these sentences is/are in passive voice?
(a) They are watching a movie.

(b) The clock was repaired by Raju.

(c) He is sleeping in the room.

(d) My pet dog bit the postman.

B. Short answer questions
1. Write one sentence of each type — statement, question,
exclamatory and order.
2. Which job role do you wish to pursue? Write two paragraphs (about
100-150 words) about that industry and your career preferences.
Make sure you follow all rules about sentences and paragraphs that
you have learnt.

Practice work

e Practise speaking in complete sentences with your classmates.
e Practise speaking with proper punctuations.

e Practise writing paragraphs on different topics.

After completing this Session, you will be able to:
¢ identify the different parts of a sentence.

e differentiate between active and passive voice.
e compose different types of sentences.
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2. GHRIAD WHd & Wed & Gdldg de| 9 & & FE fha
B fodl & d BT U XA H DY Heg N Ghdl B |

T B QBN G G, MY I PR H e g
IR T 3 |

FHRIAD GRCHT & 3 & Ul x|
olgd H HRIHS BF & HeHl & Uga By |

Wmaﬁwmaﬂﬁaﬂ# forw Swam fear o @

qEd & AU 3 U PxH B ol AAWE TN W UM bfed P

ahd 2| gafory, gRum Affa=g Ue @fdd a1 Wed @1 quie axal @

W SE UGRT B 99 URVM W I dfed @Al @ O [l ST

BT S XA AT A a1 BT YSM A @ v ST fear o

g

Uh Ay BHAR) B Gfpy R gRemm IRd B =ifeu| fwiRa et

T e BT U B D folv Afdd Bl A 3MIWS $HeH IO ey |

W(Fﬂ@ result orientediﬁ'\ef Eﬁ?

i) W d iR & a3 3 W A b o wWe IR wKWa
Jeg fRgiRd X1 U8l FeH 2|

(i) T B IOl IR PN : Th B Aol H T Afdd a7 e
gN fEiRd el &1 [ ax & dd @1 que A Al g
gﬂﬁa&uaﬁwmfﬁﬁwmaﬁmaﬁﬁmﬁmﬂﬁm
T 2| 39, 39 B3 o W W B § R [ A B
Wﬁ%aﬁ?%qﬁaﬁammﬁaﬁwﬁél
TG fhaT, TR A7 URaaq # W THeRl e g afRu|
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SR & 9% @ gRadd Bil?

IS DI HTT?

g hY B?

9Cdd B db 2i?

oRaaHl @ x4 & fofv b9 dOrMl @ amaeaddr Bl 87
f5e U 8T =Y IR q@r A ARY?

(i) & OOEE AR SUGRUN BT ST B B Bl I gRomE
Bl U I D oIy MATID GARMA! IR SYGRV BT eI
FET AMRT AR AR P T IUel UG 2| SeRNT b for,

70 GO fB & WA Biold DI YA WET Bl U BRAT

g R AUS UN WRT P foU FWIT A B fov

| 2 Ife T8, A AU S dEl W R DY U R add

IR AR & 9T Hag &N JURia) ey fAuiRd

¥ 7eg o fou Reml aRw i R wmeferdr @ 9

1R |

(v) Td doex §1¢ : T v ® wifd & iR & forn
U6 doleX M MV |

(vi) mﬁ_ﬁﬁﬁaﬁ:wﬁaﬁmﬁ Hgd a9y 3R 3

(iv)

13

deg AR Goal setting

deg fAuRer & U8 WHsM ¥ ASS PRl © ¢ 89 9T died g, 39
Y U PN AR BH AU Fhodl Bl dY AN e forad @
forv omaws & & 89 SUd WV R S B 9HS| AEU EH
Ig TS BT PR by 6 A e o1 b9 uRvifta fear Wy

e UM & g T T, SRV & folY, UES Wdfe, SRR @
yfchar # T, aMfS |

e U W DU W UIW? IR B (U, R IZ TRH Bl
qOte B 9QIE, R 3 Bl SR A WAl @ AT A
gig erfl, uerrll @ uikar # dol aME SR URUM ¥EeR
B |

Jeg fuiRd o1 & foft W &1 ST | gy oW fb e
SMART ¥ T 3R & a1 3 2|
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e UY: fafdre Specific

Iy ¥ MEiRd T8 exd &, O I8 Aba Bl GRe ©
fe T 3% Tia foar & a1 78|
e U ?FI?j—TFﬂ@ Action-oriented

& % I T W T SR | T W A e
FeRor 4 FRi—omiRd =Ru e W @Ry @ SRy

A BT UG I B forg fmm S|

Ak B L e < - 2 e o B o G B |
AR &l g

- W PR W H qHE H e ) @ g, o 39 e
I Y oA BT QA H o A

- U B W A goad A T8 a) @ g SR A U
B B o HEIA D MAISAT &

— 7 A IR WE R qY de UW B @ forg
el i dadl g -

e JN: H?JTW Realistic

ffperm & fov @ g @ wWUd  &xT B gad A
AH-YNEHINGT S AR HaT & foly §B Al 30D
NGRS & <edl B NI IRdfdd WY 9 U BT ARV |
anWWTimely

JqLh B THT T B AIRY| ETchf, WA WM 9ed N\l
gl dfeT e fuiRd 99 I & 3R FW =T b forw gwEm
Th T AW 9T BRI ARy

IRUMA-399 Tedl & Sl 39 UPR ¢ |

e TP BE U WRT § I 3d U o &l aed FgiRd ax
Thal 2 |

e UH Toilc U fod H U W 3 dahdl g

e TP IE OF HC B IR Th Md AR db UgA I YA
BN ol B |

AR P — BT 12



et sy http://www.psscive.ac.in/Employability Skills.html YUY _SS—ST@_‘TF[ e

fewgrex g ARl @1 glawr oM &Y | 9 SWih [awal @ foy difear

3R MY, | & W A QS i & fory fovgd M e B |
wrferfafer 1

SIS ST AR 13T BT
Siaq 4 oe
aegd AR
U9 A1 URYe, Aieus anfe
wishar
e BMEI & Sel 491U
o T AN B TH Gl AN T A DT W W PR Fhd ¢ |
o UgF ¥ qUAT S ford |
W T |
e U% B WINIH IR FEM # oM ¥ Ugdl Alcd Uedll & |

5
:
=%

G

AT TH Afdd & AR W FEd 2 o 3y R Ml B IR

IR AHA G D G AR IS B

6 o T A & dR W AM § b o o
W PR G & STb IR H H B GHAT § D

To x| (H o] M el g) |

g0 f6 g f59 S BT IR DI IO 9910 & S9b IR § H @R

T @ qR FH | { AU AW B I GG H

EFEEREE
gﬁ

H oflad § U SeW b gR ¥ IdU| AN 9T & b A dI

BN (@1 TS 2) |

T g W Bl W-Ted B AR URM SHE &M H Haq
|

]

& T dforer § W d smer MuiRa oM o e @ o e
IO TIR Px4 H Aee A Al B
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W—FTeddl fodl &1 1l Soxal, STo13l, Jedi, ofelvll, agRl 3R 9ra-mai
Bl WEH @ IR H ol AU W TP BIC HEM b AR GHI DI DIRW
G

W9 Uh g IR-€R G W FAdr § d 98 Uh WXUC aled gU Al DI
sl Al ©| 98 AT g3 Ud JeAl @l Ul foRm # odle @ Haw
AT B T o@dl §| Wd Al 09 M @, A g qedr g,
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e
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4 3
¥3 9
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4
4
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1
)

o W—GMTRGAl & I IXT $ folU U HeH fhdl &I e
(o 23) & IR ¥ VP THGT T FAT B |

B 2 M
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= i S gl T == T

HERTAT 3T EER| BIUE
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o WO Bl IR BT & U KT $HEH  fad
D RN W W Gdd B el § TS A BT fAwR
BT 2|

fdaed AR Afdda eror Personality and personality traits
g faaRl, el R @EERl B TE FE © ol Ud
afid @ w A AT G ?fl

foar & BT 2| W0 W Afd@l I MR < H ARyl
e e 2|

afid &1 afida TR & T del &1 f pfid awar g
U FHRAG Afddd d8aR Uae, SURHA AR TR & |
wiereqel deel B 9Qr wHAT T

g Rk € o el afed @ afddm &1 auie dRd §|
39 U MM B TS Ui dRE HI BT S § SR Aed @l
A HREG Aied $el ofdl ©, o THueyd (R 24) @ w9 H
e fhar T B

o QAU : 3FJMd B B foly Yelud dlel eAfdd, M aR
R, @, e, |fhy, dde ok wed g g IRk
ol afdd & 985 9 dkgq, 9u o 9 e 8k
AT I H B T, AR A ORI R WM UEE
T O Afdd & Gl AR are FET S Ghar g

o ﬁ?Fﬂ Consciousness Eiﬂ%l'ﬂ ST U iR ST @l
Jae G 7, W-STRING B &, 31U @M 9 W
HRA ¢, WA Y UBd GERI Bl Q@MW axd § SR GERI
Pl WA B WAE PRI 2 |

o Eﬂ%ﬂ'@ﬁTExtraversion : Eﬁ%‘jﬁﬁ Hfed agﬁ?\fé\_ﬂ}[ CIES|
U B Al @ 9 §iadld )l U9E dRd @ 3R
IM AR W, I B 21 S Afdd, W STl W GRd
g Tdar g IR fHAl ff @1 Sfidd 9 wear g
IJrAfea iR Te I @fed B E|

W-Yee Pl




s

fdd

a7 24 : ‘98 919 FRF I GGV BNE FigoT

o WEAT BY I &WAT : U9 AU dlel Afad, M AR W, TG,
TR, FEANTHN, TR | R §Y iR fEreda g g1 9
et Rafd # @e o wmfvd a=d §1 SeRw @ o,
ST AN WeE wRd 2SR R @ S@d dRd § 9 3R
T WEAd & O & |

. H‘ﬁﬁ&j@ﬁT Neuroticism Wﬁf&j@ﬁ TUh Q@[ faorar % W
fed ], MA—deg, ade, T IR IY FEE  THRIAD
wigrell B AR gad fead g1 @, e g 9 fed o
HioAE BRIl © IR Il & IN H 9gd e I BN g, d
deae & e foard 2

IM Afddd fdBR common personality disorders

afddd fderR # @Rl 3R @@R & ddalfas Yed IHd gd &
Gl SRR 3R HOR B T| Uh i fdBR AEd, HeEd  ae
IR WERR IRA B Th NG & O ARG quemsl o faaferd
XA & AR WHC B DRY AT 8, Ol AT @ AT 41 &l g

FoeX & : AfqY Suspicious

IR & forg, a8 TR B
R M R W 2 WA ARG IR A BN b davg 9t @l
T W gHI BT 3] 98 W g9 SRl UBT PRl § 3R

' & 4=




I S0 fou SR wWiadAd URfhaT &1 RO 4
T AR AT Hey vod ¥ 99 dhd o |

9 UPR & Jfddd fderR #H qRer wcumel 3R IGERl @l
faoroar <t o 8, O oRaRy iR iReR el WradIHS  SIReRdl
IR @f BF B WG B S ol B SeRT B foy, Wl OB
| U6 B g W9 W S9 ®H 3 fad € 98 e B
g AR UM TRAl W ofSdl B 8 TAA F WREgd b pifRwer o
g SUb A-fUar iR Rriel 7 S9e WY 9d e
g ofbd SH JBR H T IR S W femse
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U W Wl B! WG B B BRI &, AR H UK,
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3Ha BT & | HIAIHD IR, fEHd v 3R MMl Fa8R
1 TF Ucd 7| U i [AaR arel dnll # aeieedl & @R
AR AT & FIH AWM g | dauyl geRl § fued § 3%

HfoATg & Fahdl T |

o TlCH KT Histrionic personality fieR: Tcon afdda
foer @ difsd T IRR ET AT 89 | el &
dig @ HIRRT dRd §1 T MeEer A R & forg
988 FIgTlle € SR T Bl qFI W YA R Fhd
&

o AR Narcissistic Ifddd fIBR : MHABM  narcissistic
gl fddR arl T AFd § b 9 gl @l e o
AUH Fe@P! | I UM I AN B ol WEI
I B § SR J 3UHl SUAfR @ 98l B

AN 9EING WY W Y, aﬁﬁ%lﬁ
TR Wi, el AT SRR fhy o Gl
TRl ¥ oM ¥ 99d § SR SRR W, gNar a1
MM unattractiveness @1 9T BT SEUE) LRG| %\r

. IBE Affa PR : 39 e & QR g o #
Wﬁwaﬁzﬁrsﬁ?aﬁfﬁaﬂé@waﬁwaﬁ
%Iﬁww?iﬁbﬁwéﬁﬁa@%ﬁaﬁ_ E’I‘cﬁ
g AR TR B @A T ol FEAQUl Wi & bl
WWW%&MW@?
TRRdl @ fo oy @Rl W O9gd e PR B8R g, iR
9 UGR, M dX W, 3ol T ¥ g9d ¢ |

e Pl Avoidant Tfddd fIBR : 30 HCb N PR arel
3ﬁ?
@r
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. @Tﬁ—w Obsessive-compulsive &fdid AR : 39 TG
fpR arel o Ml SR fafEl 9 g 9 Rue v'd g1 Sw
PTG, QOIamEre AR IR0l W &M 9 3 9 e e
Uh WM Ued @1 fauvar @ §ddl g1 QU e @R H
qd BM W J 98S oEd Aeqd I%d @l d [l Heiae
O M R QM dlad B b o ARG Fagl B e
R qHd T

i s

2 8, s

I iR R F & U™

foell & 910 PR | I IRF IR, TZ AMUD! AR B AN B H
S PNl B

AT INIRG WRT B S Y| TR INR 3AUDH WY 71 q1Y
G H Heg TR 9hdl B

Bfod IRRUfAT &1 Ao @ U= emar W favary &9 |

e ¥ aRd W%, o Wi, a0 sk Ut s fafeciem wE 2
RN & g AN SIY W&l Bl JAd) FHRIHD @ |

Rrerd http://www.psscive.ac.in/ Employability_Skills.html @ AT A g9 Ulc
@ fory - diegd fa@m@R amuel g9 Rl @ gier uem
PN | 39H ST favdl & fov difsar iR s—amfl & de-ae e
7B TRRRE & foy fwqa e wie e

wferfafer 1

g <t

I~ SRRl

ARSI

U9 T U, Aicts, 91 YW anfe
ik

o I 9YE 910 |

. fi=foaRga Refodl & @ 6l @ &1 34 3R ™ Y Al
faPRI Br o |

— B U T H Uodl ©l 98 Wh gNI MEIRG FREE @l
ageldl PRl &, fUefuer & ok TGl A1 URAR & W AR
91 T8l bRl B |

— 1 fpd @B A ¥ R SR @l w'gE @) W 2| S
e I JHIA TgAr d A IR B I| FE RE B
T fddR &? MU SHal AGS &Y IR Ahd oe
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®. T dPbfedd TR
9 dBbicud el B I 9 UG 3R HEl e & Reamm fea
e oG |
1. frfeed § 9 o9 afdd & aff|da & v &1 @& v @
MR T8l 27
() arrcHfdeard
(@)
(7)
=)
2. ffoRad # W ¥ oM e @ oR¥ W@ & favwar &?
(@) STHEH @ldawd [dBR
(@) dRermeg Afda fAaR
(M) anf¥a afdda fdeR
(@) SR § | B el
3. %M F I, A SR AT P AEN § | I (b YBR B
Ffdda faer 27
) Ml YT Borderline
(@) RIEK Dependent

(W) URER® Avoidant

(’E[)wObsessive
T AR ® R ¥ & oy AT 3O 89 & AG IR

Ud

R T S R AT AIRY?

) SH@l 9T W 9 B

@) 59 W@ H AR

D AT Bl 99 § AIE DY
SR T

eI
GIEEAEIE
BSEUGKI

S

T

~—

399 D [N @ 915, MY IT F A G Bhl

o fdac @1 31T T |
o R Afdde oo @1 aoie @Y |

o UMY Ffdaed fddRl &1 9o Bv |
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TRey

A1l (Information) IR AR e (Communication
Technology), O Wem & omEiidl @'l Wiar © IR UE AR WiEA
T A T g9 T 2| ol @1 e drenfa (Technology)
IR AR U (Communication Tools) &I ST B9, H9,
LEALRUI (Integrate), H@'I_Cb_ff (Evaluate), %Q_C’ IR AR
(Communicate) XA DI 9T fdbfd e ?ﬂ%m EX E_fb—lg S
qU Wedle & IW A AR TF WU B SWH $7
@YUl 9 B N H S|

99 1 : Bede & 9 ™ DA (Getting Started with
Spreadsheet)

JM AR W AN qUH WA Bl IERET DY B 87 ST G GGl Bl
U SR H forg S {6 Sa 9wl @l Wha B [ 19 8k
foTel &7 fodl; ARRI 3R dUsi anfe W Wd @ W drell o |
J T foEd € & U@ Mged W fhaw @d fbar o) 8@ ¥,
Tdl @M & fU §a T (Calculate) @ W § & S
WM A fha wd e 7l Wlfed o &, A AR BRER B
ST & OFd 8, 9 309 Wdl @ ol W Y@ § fog
WICRR BT IR X qhd © |

gy ofg 81 Wedic & N H AEd © Ed ST Y W
UM (Calculation) & B forv fhar Smar g

fohe,
TE
TP
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Fedlc 16 godgie Siagic 8 M A iR afeM 8 8| 36T W S
B FIRJT (Systematic) WP A TR B AR UM (Calculate) PR & ol
fomm Srar 21 ISR @ fow, td oM @ geM H @ Mged 2| gEMGR
UG 3MECH &I g A (Quantity), 99 T AT (Quantity), YAS 3MGCH I
oMd AR o g e &1 & @ g1 39 W R @1 |l @
SWIRT @R 91U (Maintain) Y@ S G6dT & ol & diferdr 34§ qamam T
g U gdhIdaR BT Bfcd T (Calculations) B IRAF ¥ UMD (Calculations)
H H AGe Mol SN @M AT B @I Uar o |
diferat 3.4 : foRM @& SdF § AWM

Total Quantity |Quantity Selling
Item quantity (kg) sold (kg) |left (kg) |CostI/kg |pricez/kg
Wheat atta | 250 115 135 28 31
Rice 160 57 103 46 50
Arhar daal | 70 45 25 60 68
Sugar 200 145 55 40 45

Tsee R 2 I8 IRE B dC, dfelV 9 BsYic & UBRI Bl A |
edfic & UBR

F3 JPR @ Wedc SUUI & o S oufl g e e & 9ew
daiE Wefec d ¥ g s d @ g

Microsoft Excel LibreOffice Calc Google Sheets

X3

fa7 31 - @BT HSIHe FIedTY

39 WA H & R f& (LibreOffice Calc) @ SYIRT ¥ &Rd & | FTT—3TeT
Wedlle H SRR BRM U6 oY 8 &l dd MU oFd & (6 &l o @
STAN & R €, a1 MY A W fH R Bedie 31 ST R 9dhd g |

LibreOffice Calc Y& &7 & =

1. Uil a1d o I8 YR &N b AU HYLR H LibreOffice FEIdl B
e |
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2. fdeI & 99 IR H LibreOffice Calc clgy N |
3. 99 RWec A LibreOffice Calc @l Ricide ax w1 fd

| fosr 32 § feWRT AT €| LibreOffice Calc Td wid T
ST o 6 R 33 # fewmr w2

e & Yc<dh (Components)
Wedic H, MY I AR PleM H Hed & 9RF ol gg ddeie

3G P ¥ | 9, e W 5 d @ E @732@#@@;#
1. Row ERGIed (@I /am) e § Jed @ R LibreOffice c;z%

& B fw e g o o foF 34 # fewmr m g
Tforg & 9 o W FR 3 H B

2. Column (Rf¥T/dd) WP ¥ IT I NG & & forv
g gl o fo R 34 F Rwmm g IR B 3ie
ol &1 § f3u MU 2|

[k Uintitie! 1 - Libre0ffice Cale - Y S, S usiteat 1 -
Ele Edn Mew |t Foomal  Sfes  Shesl  Data Jook  WindcreX

d-BEHde@ s=0 &

(entiontane [0 [0 B Q g A-BE-= S . :

A7 33 : LibreOffice Calc &7 e | a7 34 @sehe 7 7 3V FioH

3. _\el(_"[ Udh 3gd T ATHR (Rectangle shaped) &I a9 i %
ﬁﬁ?wﬁaﬁﬁlm%ﬁaﬁmwﬁ?ﬁﬁ
(Date) B e S Wahd @ | O a9 & Riede fa
%WWWW%I%M‘#WW

TN ¥l B3 T — WA H3 W3R B W 8 — 3R g

e |
|$hest 1 of 1| |Dﬁ-l|lnﬂlhrhdﬂl | m] 0¥ Frmmagr £5; S 65| =
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B Lbvieed 1 - LibweOTicn Cak - - 39 \_yﬁ E@@ 'Jﬁ clgy W(‘\[ %\‘, dz 39 Q’ﬁ?ﬂ
Fla  id2 Ve bad Famved  Shgior Bhaal Dets fock  VBedow f[ ﬁ)ﬂ}f .

SR AT LG AG S {%3"g$3§ - m%ﬁﬁ T ®
Agg i ==s ’

o i
- 4 ef=[=% -, 3 B IR A WY STl R wiHer S
= oz \ S| Wed € oRe o ax wed €
', |T 4. WM dfew # Ryelee f5U g0 9 1 Araee
- »

J— 1| o H Uh BEMEE T| SAERIT & folg,
. o Al, S&l A @M & 98 8 &R 1 N
a7 35 . @SEe d BT aw s

5. gadic e (el &1 Ud -icdd & ol Udb GEY Bl 37el &Rl &,
JMIATPIN (Rectangles) ddl %) b T B Uh HIE (Collection) g
W9 A Ugell gR Wedle Wield &, T YDl 'Sheetl' & M B AR
6 ©d Jode e <l 2|

6. IHgF TP Tedlc ¥ M w6 A1 I99 WET d@ee Bl 2

yrfTeD 3R
http:/ /www.psscive.ac.in/ Employability_Skills.html UX %—aﬁﬂ AT XA
PN | 39 S fAwal a1 difear R -9l e gRfi| s-afiT @
IR W, FrferRad Tfafafy o |

AMUH! R AN & & T THMRR 3O FA18 SR @@l & Rafs bu

T 87

RIS W T

AFT AR oF & folv s—af T o e @ TRifdf 39 |
Tfafafer 1

e X

LibreOffice Calc ?5 T hlH dRAT

AaeTS AEREN

LibreOffice Calc & HTT U T URYe, A1Cgd 3R $YLX 3l |

fshar

o JUAY FYS DI FET b IJER W, FeM d WHgl A fawiird
| Th A 9 e go, off 39 Tl &1 PR we

o olieY W H T?Q RN fAeen @ SRIN W UX LibreOffice Calc
Caliaul
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TR B UG GG WUl & TS HCh (Component) I UTAM
HNAT 2| I GSWl Bl Biedd o AU & @ W 2 SR @
T WE & 99 6o UYgdM by Y Gehl & Ale W I Hahd
g 3R ® gFRed = Fad § & I8 N s T R

Ul Alegd H A QU MU oyl & IR fARg| R, 3wl
TEH @ foly §—oldd Fay |

®. 9 ddfcqd T

1.

......................... U6 Ioldgitied e § fTadT SWIRT STl & gaRerd
Nd F GUBId (Store) A 3R Ubh I Udd (Expense sheet) Gl
TNE MU bR B forw fbar o g

(®) Breie
(@) aadiie
(1) aPgD
(8) =9 §fex
2. Brediic o WA ¥ = H 9 oF-1 B fhar S |adar 87
(1) Rofs @
(2) dfsar g
(3) SeT BT fagetyor T
(4) BTN bR HI Y
(5) g fer
(®) 1,2 3 4,5 @)1, 3,4
(M 1,35 (6) 3, 4, 5
3. Bfom W M @, R iR, 9 SR |
1. aidpd Bl R BRG<d I @ e ®. X
2. M EY1,2 3 4 U Bl BINGlcd Fawell g, qhqd
3. ;ﬂ?;ﬁ 3R o™ e %\' Il AT (Intersect) | 1. Bl
4. 9 e A1 U6 W R dodfic & g qd
5. A, B, C, D ¥ dlc] Aol @I diehd avell S T9dfic
(@) 1—8, 2—, 3—1, 4—°, 5-7 (@) 1-8, 2—9, 3-7, 49, 5%
(M) 1—®, 2—Q, 3-T, 4-°, 5-§ (@) 1—8, 2—®, 3—9, 4—, 5T
1. U B GO oo giRviicd e & @ ol 2|
(®) dfem (@)
(1) Bt () addiic
AT IR IR UENfia! drerd
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I D e D 96, AT IS BR A e Bl
. Tsdfic & AE@ QIR SHWN @ AR |
. fIfr=T Weelic SRt @ Al Y |
¢ LibreOffice Calc Gﬂ'q:f aﬁ Gﬁ? Udh @@ﬁf EHT(”
. Sedle @ gedl @) @ TEaH e |

e Wedie &1 SWE o Rl of axe @ fou
T T P ST B gl 3T A DY S, Use B, feoie N IR
ST BRE BT ST BN |

ST BeM B T
Wedic # fodfl fauy | d ST S & WO AR QU MY g
I I9 9d W fodd & && U el e i kY=

ged © ow & R o1 A feamr w2 ~

XY & oIy, 89 ¥ Al R foadd axd 3 @H
.NEI
3

CRT I AR TZY BX| O & 3MY eZY I
g MU Bl IR H 1 ST <@ Whd T

=R o S T e - B [«

wﬁeﬂ%rﬁf A2 BIR ATl T W Je B [ ' - kY=
8| AW Y STl SO TN ¥ o L
e

S
ﬁ«? H Se A (Rwiee wu [ L HEE

%) TR (@ B AW R B ) T S

SITQAT ST fdh aMmual Ger fhar gonm coe o

il

ob w M

¥ fowmn mar § AR e HR S § M - &L=
A T SR TS BN 8| AR W fy oqwe | M—1_— F
Ud & 9% AR TS & Gdid FR TG AR | 7 g

g
ST 3 3 : ave YellgTHe

AR P — BT 12
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qu 4§ fe@U M AR = B RN
et & 9 Yo PR Uh A H Ud
Sl Whd Bl UT boldgelRd IRd oM AR
Retee 41 fome |

2 ;’_ l d 134 T

T |
R

i l .I
£
:

a7 4 : Bged @ [y = @7 FYIT BY

el & YBR
dF & YHR & ST B & — Cave, FeR 3R B |

INTdd, Wede ¥ fer, diffedn, difsar ok I &
ST W1 G9g 2|

afelt ewd 2 &6 Saer S feg fou fear omar 2
XY B GE Pl Th PN ol 8 9 aegall, o g, e,
gre, M, afe &1 Rale @ar g 98 a¥ell & W, W
P ARG, WG TS A, A g, [P qe, afe &

T U6 Wedic @ STEN @Rd gV Al & | 99 JMgeH
TNIST of T4 98 SRE Bl STAN Hxd -M, A & folv AaR
SR AR ARG & oy feHId &1 ST R [ @ |

Udh Jqd ¥ e ﬁQ%‘C’ ®YA] Editing data in a cell

Ife XY, ATgCH & T DI A I3W D qod NIgH B
M S AEdl § Al 98 39 Wedle § Ulse (W) R
qHdT B |

fox 36 & fewmw T A= W@ ¥ A9 @ e W
qad g

1. 99 Ud R <9 fdodd dx O 9 Ufse oear amed
g fhe da § a1 wiHar IR H URYHd RS TRY &Y |

2. UeX <9V |

1. 99 A W foode & B oMy ufee avar @med 2

2. TR B Bl IR | F o |
3. TR <4 |

@ o ¥ H RS I Q@ T W qeaT drRd g, dl
= et B )

1. 99 R s o)

2. T THRE TIRY |

3.Enterﬂ_6|T§f|

AT IR IR UENfia! drerd

i ﬁ:l:.ll’ﬂ_.l.ih-'

Ml =

B7 36 10 07 7 dme 7
vfee &
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99 ¥ 9 s g Deleting data in a cell

i TRl T = hvils
o L | am e R S A g d @ e
o, G e Bt wed § R f6 R sz A Remm mroR) w9 A
D | mow om o® 1 ey gl D w0 FEER §
e
R 37 0 & dq @ & 2. B4 W Delete @I | Jg 39 Ul &
SR Tl B Wiel d¥ ol g
B3 A0 Relde HRAT
@, Ife AN T W G @ A @
ECH IRl 2 Al 98 Q@ X B Rfelde R Fahar g,
IR IR, feclic gaW | @3 Ao @ Rdde o1 @
9e, 9 Wed W TP GRE B ol Riddde | o9
foey Rt da @ Rioiee fbar oam & a1 S
Ufdcd W del Ol g 9 By Aol @ Rflde
foar oer 2 d9 39 A Nol bEl Wl g B
e 2 o I B Rielge foar o1 daar
g o & arforer 32 § feamr mam g
dfereT 32 : B8 Vo B Ryoee HRAT
fﬂ: ELEV I e e g T = :
i T
- 'LE 'r.r:n“namﬂ 3|
f *%’%‘T
) Gowds InlepcorpBbce 7 ) m r
ooy Saia G g g | |z (Tl fQuanity Kuaminy cen  elleg Prics
Sl SEEE] e = P i
g‘iﬁﬁf & SN 9U B W%Wﬁwmmmg@ﬁ Aol T @
: fo, wifdt 9 W fodd @3, R w6 ged

NG W fdeTd By |
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AS = & = | Arhordoo!
A ] C F
EE ; Goods in Gmcury Store
2 Total uantity Quantm,r 05t Selling Price
“ item Quantity Id “/Kg |¥/Kg
*?awhut atta 250 115 13 31
4 160 57 0 413 50
_SamArhai deal it 45 Za By il
£ .!Sur_.;nr 200 145 55 a0 45

faf=T Ul (Formats) H WS & AT H=T

<Cl T B 96, AU BeHle $ I WE F AlRYS Al
forefl R I WA  ®Y H FI WX b 2| File W
facte &, IR R, for3 38 § feWU U AR Save o |
I8 Ud Save As ST dfad Golll| file name T[FY $Y
3R save W fdeld & |

Save as type [$®Blcc ODF BIS¥E (.ods) &, olfdd
A Wedle F T We W YT PR Ghd @, od
Microsoft Excel 2003 (.xls) S fé fom 39 H fewEmn

T B
Edit  Wiew [Irsert  Format  Styb QDE S,pma.dghm ‘gd-g]
B » ﬁ o
B o Cinso | ICDF Smeadsheet fempiate [ots]
B Cpen Bermote. R g ‘Flat XML ODF Spreadshest | fods)
ot Do eyt = ] {Uinified Offica Format spreadshest {uos)
% Cloze = ot bl crosaft Excel 2007-2013 XML (dsx)
: 1“&[[".'4 Microsoft Excel 2003 XML [xml)
(5, Wizaids » I Wi crosoft Excal O7-2003 (i)
Feniglates L4 Microsaft Excel 97-2003 Template (1)
i I— \Data Interchange Format {.dif]
i [ dBASE (.dbf
m cEies | HTML Doowment {Calc) {himl)
m Save Femote... i SYLK ':'SIk;'
MW Sove s CuleShiles Text CSW [.csv)
R Office Open XML Spreadsheat [ xdsx)
ey Microsott Excel 2007-2016 XML (macro enabled) {adem)

a7 38 : v;?@'?ﬁa’aﬁ‘v?am a7 39 : TX WiAC 7 6T &

WSAE P §g (Close) BT
Uh dR old 3IU é,ET _\'el?,[ Y aﬁ %l (_‘ﬁ' File  Edit Wiew Insert Format  Styles  Sheet  Data  Tod

Y File N fddd owa Bedfic @ d< = 3‘:‘" o B REBE- DY
(Close) X q6d 8, 3R iR dg (Close) | B Open femote.. ag a-=-

E}ﬁ’ aﬂ‘[ ﬁ? _%‘a 310 _q_ f% T %l . Recent Documents 4 - =

a7 310 - G F g7 HVAT

YA R HAR YR diere .



Bie| Fdt View lnsert  Formd
= -

Recent Doouments E
M Close

[ Wizards

Templates

Faoload

Versions .

Sawe il +5
Save Fermote...

Save A Cirl+Shift+5
Sawe i Cogey

Banwe Al

Expionk...

Expowit as P .

Sand L
Prviews i Weh Browser

Print Preview CirleShift+ O
Brint_.. Cirl+ P
Printer Settings...

[Haital Slangtures *

y| mma@s aw

312 Bedc @ Mz &var

$e s

Qe Gia

File W fidd o, 3R W,Openﬁm—cﬁfaﬁl g
AR BRdll @ U6 foRe & WM UG SRGNT 9
fe@m| fod e & Riede o 93U @ieFr aEd
g 3R frg 311 ¥ AW Y R Open W fddd x|

File Edit View Insert Format Styles Sheet i

] New

I Open Ijerni:e... a ﬂ E x
Recent Documents »
M Close C |

il 15_'.'-‘_1:

a7 311 - @S @erar

Bedie @ file o

Tedie fiic & & foru, AU File W fadd &R Fad
g 3R fhR, SU-SST 9 Print & Rididec & I diEe
W Ctrl + P Ta0 o1 & i 3.2 # fewmn mr 2

Print W SN diad fe@R <ar g fiex, il &1 ¥
3R fiic ¥ drell BT & AR BT Relde H AR 7 3.
13 ¥ f3WU 77 AR OK W fddd x|

Frl

ST i

el

= 0 e (A

(el |aeC%oe Ol Pacw Lyt Czlom
Furrie
it Muckcanat (A0 s 8
A% Pyt m AR
Micrasay 1% Daasmend Wiy
L i
i Py
Ravuge il Lageies
1l vty Herbeciogin | 2
% S lee T
1) ot il s =yfL |42
e syl gl
¥4l pm
CiPsoM
1  Prmtin e P e

nE | Coresl

a7 313 ST §iwT @ fe Bvar

AR P — BT 12



http://www.psscive.ac.in/stud_text_book UX é—aﬁﬂ KRR aﬁl Wﬁ SIRIG
fowt & fou dfsdr ok s—umh wfia g1 - afFT @ SR W
fy=ferRaa Tfafaf &9 |

e @ IRRS Tffaf

AU R A & b VP GHMER AUl Rdle g6 4 4 UE @l felle
TR ST AR R T & {6 o RBid 16 BE &1 9™ IR 4
gl <M, R e B fear &

TERG g 3

TfAfaf B D T BRAT €, TIBT [ART U axA & foly T o
BRI

Trfafafey 1
e X
LibreOffice Calc § STl & W HM el
I CRU G DR

U9 I UR, HRYCR 4 Sl (AT §3N LibreOffice Calc, 3M< |

gfsham

o UMY I B G & JMR W, FET & GE H (o o |
U6 T @ olex @ Rielde & |

o AR TH Wedlle Wl 2| Udd e Bede # Ueh @AM,
A FR® AR T ¥ S 2

o T WeW Wd © 3R 39 W Ul <0 F 6’1 W T AR @w
JER fHa1 S A |

o P VSHC & & TS dAlMcidl B WRE (@ AR |

Name Roll No. Date of Birth
Sushil Kumar 123 15/10/01
Meera Rao 124 26/12/03
®. g dPicdd T
1. WY # Tl SO B WO Bl Fel HA &
(®) ST TRU I, ¥ W fdeld N 3R Enter 34|
(@) W W fddd T, ST <8 TN AR Enter 9NN |
() Enter SO, ¥d W fdadd @ IR ST <RY BN |
(=) ¥ W fddd N, Enter U 3R ST <RY BN |
2. WUl 4 [ Jaie @l felee &)1 & oy oMy & FHI?
(®) BI3d ¢d W faad & 3R fove | UUct @ Rielde &
@ ¥ I ;T R B W
(M) Ve & HU aN dH H T WqeTd R fFad o
@) ¥ PfeM BT R faad w

AT IR IR UENfia! drerd

49



sﬂwzﬁwsﬁzﬁm MY IT FT H W B
S T YPR D YgAM G|

. TP Bedie @

e T U, Tfee 3R feefle o=

. B3 TG Bl Relde HAT|

. edfic B AT BRAT AR T (Close) X

gedlc d ®R by §¢ ST &1 SWINT doldgele, UMb RYice™ 3R
NGkl IR (Display of information) d feor ST dear g1 dfew
S P AT M I B IR H SR ARF A |

3'\:@ I Wedfic BT YA HRAT (Using spreadsheet for addition)
Gedic d SWR GRAT Yo PR QA 8| Iv AR fawal H s

BAl & 3F S g ool & REaaa H R@mn m ozl oW, ' oudd
B & Bl AP PN U AT ARG | S T AT AN

W B & qd JB BT YA AT D

o R X Ry 3R vw R d o @) e
| A B f D BT Wedfie § Wie @ forw wﬂv
F !ﬁme E“ﬁﬁlﬁh Mmhs MHF':- ey BCRIBRE IR GIED (Symbol) (SW) “+
E‘j;ﬁﬂ ; ﬁ = e (@) 21 o Wedic § ST @ l%FQ
1 by 55 5 T = W €1 @felt 89 ol fawR
a7 314 o779 & IF i st x|
z &L= | wefe § W @
] A E | I: D “ alculation E"ﬁ— W EB W
3 Mame | English | Maths | Science | Tolal (S 1( - RN );R-ﬁa; (Symbol)]?; ST
WRohi T3 & 78 B R |
1 Sania B6 90 88 , -
| & gy 55 i i I ﬁ iﬂﬁ; S o ﬁ%am
ICERIKAE (®) : W TR &l (Calculation) T AR Rofee fezgmmm|

fo5 for 3.45 (@) § ‘=73+89+78' fe@mm T B
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T MY W TS Wl H CRU PXd & R
Enter 590§, a Rofee, 3rfq 240 famamqam|
M < b Formula Bar H qv"uI‘iT*IT fewgrar
T g oo fé fom o35 (@) # femmn wmm
gl

U Ugd @ SWR e wrew Adding
using cell address

g T BT B I SN B 3 Terd

Sl B 96, W W BMd @ R W S

TS| S@ U 980 &M & Hifh Sl e
440 3 3| WU Y AUl HA VA
(Calculate) ® @ d8R TGl fAear &1
Bl H WY AR B ST G b 9,
A B 316 (@) # f@W T AR WA
TS9 BT ST R Gohd 8|

SEERT § [y, =73+89+78 TlM B
9N, 98 AA Tgd =B2+C2+D2’ STl Idhdl
g1 s A o R R I8 Brer 98

¢ & ol § geag 81 W W HA Bles H |

Total & R ¥ TRU x4 @ Wd &l &
o f fom a6 (@) § fwmr war g

BN Cled 3MU=—3My fhy & TuMT (Calculate)
R M| Bl ¥ FI3 IGad el B S

gl

o 316 () H @ ARG & SAUSH IS
73 9 9SAGR 66 B AT T| TIcd ool oMU MY
233 B AT &, Hel & Bl H Pl dd A gl
8, =B2+C2+D2’ v f& fF 316 (M) H
ferar I 2|

2 ~ & T = [

| # Sau8 R kT

B2 T EYE o :
| A U {
| Mame | English | Maihe | Science |
I [ - I I
.| s Ifll -I' l:‘.lE 1
4y
fa7 315 (@) - '7771?%7 T 7%/%@7277 s
i T W R
- b L [
| Name | English | Maths | Sclerce | Tatnl
] WFchi iq BE Tt v )|
AL "D= &) |II1
4 '.'il._gl,
fad 316 (f/‘?) e W 397 67727777
i.“; L RYe e

A ] [
1.1 Mame Eﬂn_llsh Maths | Sci
Elﬂ Lo ™ :
T SR I'II“- | [2F
d ".".@1

L 316 (@) 697_9%7‘&778?87

A B i
Mams iﬂgllﬂl Maths | Selence

Il'*m | C%J 2

L ey = il £4

faF 316 (7) : cicer T & T &

TP B § deg BT Riclde &1 & Y 4189 &1 ST &Rl
g9, v fomd @ forg, g v @1 YRS WA B W Ugd

T UA I ERM R I TRU FA ENM| SHD U FB

TN $ Bl OwRd | gl T Bl Wedic ¥ B &Rl

3N B I B |

YA R HAR YR diere

51



RERdag LR akiahal o
. ,ﬁ;e i L T | S T @ IO B § ST fRy WM drel
3 T _.-.&' J# ., 3‘ Ud B Rfeldc IR OWHAT © ool fb foF 347 A
4 o 2 fewmar %I TR T IR & |

A1y i o R vt # Ay 98 W A < D B WE 91 ded @ AR

T BT GUIT BT (Calculate) AT TTEG & |
1. 9d R fdae & oo Afed @ el ofd 81 B2
Bie § g |
8T |
¥ R fioe & i IRd @ @ @ e 2
C2 B # faw@g <)
4 ‘+’E‘|?{C{E|”ﬁ|
5. W (€12 R fiode & v ARG & fage @ ofie
g
6. Enter <9V |
T ol Bid @ Ted fomr o & der fhar smom
fored gt ot 7 Qe fave & yaie & fou 99 Ugw
ey fooam &) w8 Yy 980 oM B @M R W, 99 %
fawa 21
i E R | o Bt S | [« B v B e
A [

_ YAl (Calculations) ®XAT  3ATHIA g O g
g Eil"”“"“:;'“ Wl Bl Sed @ fiU, @R UM Sum()
BRM 8| T8 AT Ul § T el W H

4 gy Range == | | [

R 518 (@) sum) 577 @7 Gyl SR B e ¥ wee ¥ 21’ 318 (@)

BT AR (@) # Ry U SSERT H AT b P b

d IS TP UG A H 2| oo fb fF 318 (3)

IR 318 (@) # Q@™ T € Sum() BHRM
zﬁrmﬂaﬂﬁ?ﬁwﬁﬂﬁﬂwél

" R E = SN 1, TRRY PN ‘=Sum( E2 # &l A T BT
t | Mame [rghﬂ.rmm::m Tulal EIESI
.113.1.2*1 . 5 2. 3/, S @ P IM B2 W fad @,
4 oy WWW@W%WE%W
a7 375’(@) SUM() WW IM D2 % drag ®X| 3O Ml AWl @
ST FVT @ S T del B Riege e wro|

3. ')'a's{qaﬁ?:ﬁ'\’EnterWEIﬁI

AR P — BT 12
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T8 ¥ R E2 # Rulee 3R Formula Bar #
e fEm &
BIdell B BV FIY 7T BeT
o P T A M B o A o
(Calculate) T D foll Sum () BRE ! "-‘-“"ﬁlri Scle 'ﬂ““ﬁ
I SN R 2w oI Wh s eEl | oW s e

BRT 4R @ & R RARARA | = o
B T &7 T8 A Wedic B @l | —

Th 9 W R A I A B U R 319 : e @ @ avr
TIST qA | AY BN T HeH H 0

1. BHd & 9 Wd R Ad @ |

2. ge—faad T R Copy Ridide & o f& frF 349 & Ry w2 a1 dEe
R Ctrl+c 3aG| IR oMy fo=fl 7 ¥ § Bl & 49 & d=d &, Al 3
AT dl ¥ feclic R <, dlae W Cut I Rjelde @X I Ctrl+x 9 |

3. Ul ol W fddd X W@l ofydl B BIU BT 7 |

4, AU WISY 9S4 B A G g RN A TP UgA OF drag N, W8l 39
HIHAT AT AI8d & | e A9 §ed @l BlS |

5. W—ﬁ?ﬁﬁ TN 3R Paste T ol =
fo = 320 # fo@mm mr g A1 ol T D Ty
PBIS W Ctrl+v T | e T
6. BRET WA Riode Ry gy we e e
S BT S| 399 W BH B A —LLc
Qe 3f® DI TUET (Calculate) Gill f:'" S i . ,
ST _ fo 3.20 - el @ dve @
Al v o gW g Bedlc d S FM
Pl A g1 feam 81 3/, 5% 99 a1 ol © 6 &
fovr & fov o ol B @ 3d S AR 9@l
wedfic o) 3R, IT HB AF dSad @, Al I [

BT ST Fxal 8| P-4, | IS
forgct 8 afd I8 el fow@mr o
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| TS TH 6 TG UM UH A% G 96 i T| W Pl 9D
AlcE ARAT § WG I g R T M €, 3R wewyel figart
Bl WE WY Y TRARE [BA T T

Sldgie BIsdicd H Audl WAl @l 9% R Ugd H oMM
g9 & foru Zb_g A B ?\ﬁfuﬁﬁﬁﬁ formatting’ del IIdl gl Eb‘:f
e © oMY g G @ U Wedlle # B dX Wdhd 2| sy

I A FE b A BH B

N CRS WA AR BT WEW 5o (Change
v -B-E ASm AU T A& - Qgrs text style and font size)
gomezsdss AR gu ST B TE AT Uell A T
_WWWW?HTWWW—W
[ " B ST IRD RS Wl Bl 98 dhd

T %ﬁwﬁzﬁa&mﬁﬁﬁmwﬁl
SILEN-ILESI N d U TNHE @ YerRd
Swnammaie sy | Tt R A e
Boutmesd Hu- L& il =-S5 == o o
R T WE, MU Bie—dZd gu-s6d I
W CRT @ AHR 95 Fadl ¢ |
£ o e = A S 5 oam s ¥ @ wed g
fom 322 : T Wi SIPR T BT Bie 3R GBS ged T 2
A § eRE B Ucllg- i (Align (arrange) text in a Cell)
il g9 <Ed § 6 SRE B WA B Ve H @ T R
Ig DY BT 2? e Bedic H AU TRT DI oS, Wgc AT WX
# X R Ihd 2| TE BT B TAGHS BITR B |

ST R d i L S AU CRS B TAlRd I™A & [l A
S ‘;Iz,mi T Trheaaas ROWR ORU MU EET @ PR
) Pk y % MW 3 323 # ¥ Al, B1 3R C1 H
' SRS B WX § Talgd fbar mr B
A7 323 : SR B TellgT BV @ Whd § fb d9a Ryede fbu U e
Pl UeX H Yol fhar T 7
CRC @I BIgeligc PN (Highlight text)
T U SfRgHC 3R <IGH B oieN B RS B 1l ol
@B o H g9l SR dles AN § b d o W | B
R T B N G a £ A IR R A
afe 9 o R | o f aiferdr 33 # fewmr wm R W
B3 WD & NN 81 R B U6 VYl § FEelge &
qHd 2
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IfTeT 3.3 : TRC Bl TIZNZE PRl

fopa Ficdhe B Tl IR ATSHI
Action Shortcut keys i Tool Bar icon
é_(‘RE Em- Eﬁ@ Ctr1+b | e+ ey Sianvivs
FGIGIH AN
o |Ramsh
__(Mamar Ry o nn i
3
=15
SISNCIEREC2S = = e W = | Mare - T
- Eﬁi‘ Flowy 78 a3 B
£
B
SRS B gefoId Ctrl+i

| '3;;;"'.7{';;-.'.'_7“;5 'TE; F-ue g
T fORST AT : Fa™

S

http:/ /www.psscive.ac.in/Employability_Skills.html WX s‘—aﬁv AT
W B | T S fawat o1 AfeAr oiR -l e &l | -afiT @
IR R, f=frRad Tiafafer o |

A &) IRMAS Tty

I R AT & b B Wedie ¥ AW @ BiEc X B
TG 27

ARG T N

TR @ o9 I €, THHT ART I xR & v g—af1 e
T |

Tfafafer 1
WE NI
foraRaThd oo § Wedlc Bie e

S AR
U, forsl Siifthe el S¥eiel BR & Wi HYCY, 3 |

AT IR FAR Yreifien) drere

fw
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yfshan
o BYXR B TR b AWK W, FeT BT Al A ORI B | TP ofie”
£y

S ffaf ar fERE B
1 ¥ fR@rr 1 & e diferdl 99T 21 Th 9o I

RIS
FR R M P ¥ Fex Tellgd dal & |
Th I

W W BleM BT P dlcs Al &l 3, HB IAY
Fic efST 31 TART IRA T1 T I Wew [ M fafrad

RiCra)
M & T%N B § BT Al 931 Gl 2|

l: ¢ o & 1. —_—
| A 1] C O B | i =
1 IRl M0, Mane Ergish  Hindi Mlcating LR E (R E] Tediad
2 11 Abhas Shae (i3] L&r < LT 270
i Aailta Sofigh o it} g3 B 318
- S EATIAR (] 5y fi a5 R
5 4 Uiy S BT ES a5 14 il
&5 Priya Tales TH L] an ffi 330
16 Cioutpm Gk 54 45 50 il 211
a7 1 - TRk 1 T
fcfafer 2
LibreOffice Calc ﬁf glila E«‘ 7]
AaTAH AR
forsl offfhd b & W UA, UR, Y, 3T |

afshar

SUAE HIC B G b AER W, BT B owE A AR @ |
TS T Uh ollex Bl gd B |

ey Ue Wiedle dliuT dxar g1 ol 6 fTE o1 d REmm mn g
yd W Uh Ul [, W, USll, gl IO AR fawE A g
APl W X FRAT © IR DI Sl H Bl 3Bl Pl AU bRl 3 |
UH FE® G T G D o Ub el A BT IWIN @R
WHAl 8] I MW o9d ¢ AN Wl e W @ fbu M R A
9BR B FHAT 8¢ $9 W UARHAT <4 g Ul Wedle T 4 g

et @ TRE foas @Ry |

o7 e T = SUMETFD
A B € D E F e

1 Roll Mo, MNeme English Hindl Maths  Sclemse Total
i 1  Abhns i ar 56 ] L
3 2  Ania ) [ i I} 314
4 3 Flj i A iy e P
s | 4 Subhy 81 25 a9 B J-d:-
] 5 P i b L] BE

Bl 6 Geugn 55 25 50 i “J j

faF 1 Ta[E 2 a1 FHT
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[aN

¥ et @ feblee Udigde @1 2?

i
1
3

3. WA H RS DI Ualgd o4 & fol Jehe bl T 2°
(®) ctrl+b
(@) ctri+i
(M) ctri+l
(@) ctrl+u

4. Bdfie ¥ faRd ueeH o @ fou = & 9 o wied @
ST fhar Srar 87

)

U T @ I BN @ 91, MY IT F | WeM Bl
o Yedic ¥ A 79 A<

o W B IWN b A WS |

e Sum () PRM & IWN Rd AF TS |

o Ud H TollEd (FaRerd) TRe |

o o ¥d H fie <we|

o TRT DI TIAZE BN |

33V TS foemer™ ® 500 BE & SeRVl o | 39, I Reme el

f99Y B & ok Wl ARl §, SRRV b (ol HHr, a1 SH gl

AT IR IR UENfia! drerd
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T qE BRl| AT U Ffod U B IR SO o9 W o 9adl @
Fifs Regd d WA 500 AH PN @A USAT ©l o€, AT T AW I
qUIsPA H aRed @xdl & Uld T U, o AW @ & W T, AR afa
Y IS BM d AW SIodl §, M el M B WIQWT| JMUSI Tl B
fo, A1 TH 3ER W YW BT ©, O 9@ H JMWM| YR DI HAGH DR
I AR e H Rl Ry W AT AW B @M W WM H AGS

T w21
] : 5 : STl HiE BRAT (Sorting data)
'ﬁmimﬁmﬁmﬂmn“ﬂ T R ST o ¥ gl v @
; Zak 5 & w8 m ow oI g BE b QW & 3P AR Th
2y s m o n L L Ot § 9o A oo f R o34
] EooE B8 U Rgm w2 AR T v AR @
'Eif_;m B % i i B o I A9 BE BT Udl oMl dredl ) al
e w8 w a w w SO W W AW Efl o oR oA
1 8 o385 r o om PRe ¥ AR W AT A e A S
e ]55,324’" “”\3:7 = E g w100 I S af¥e B )
™ AMH T B Y, I G Fd W ST Bl WIS
TR Fhdl § dld 98 T H BAlI B X oM 9d | <2l Dl
e oA B W 39 IR F|
1.9 ¥ R ofem @ Reiee X R fF 325 H
fegrar T %)
2. S W fded @ iR R o f& R 326 § fowmn
T B, WiC (BHIE) W
IR d0mLs " b6 - Qrebid|  |SnE dem §s CEE— 2
FUTFETILECh R 2t y Bacadiiss e
}I:-:l“ = M . i e I
L p——

n [ i H n 73 TOTAI
il L] R L] 2 ] ) Im = '
) = [ i i 1 .
= " o o W ] | n ]
B 1 1 5 B B | L1 3
[ 5 . | a N i i o E
[ u [ o [ ™ | % 3
'] n M = M o i i '
[ [ - M u T | " '
& = I & o i M z
# a " B u i, | = 3
| T 1
/%5'325 wie 37 @ arel Ser @ Rieae #Y 7

/%3'326 éawﬁawaﬁaﬁvﬁvme‘g#

%% AR BT — Pel 12



| feplec WU W
(Ascending) g, @ a1

ITH qdH | g 3 ARIE
TE K Blos H S Bl WIE |

b G
o, ¥
A

M [

77 327 : @ic SIIAIT §iAT

. . , : A i L O i
. ~ 1| K fcicace Mafks English Himdi 55T TOTAL
T F R W waReud 8 WO R e w e e e : J
. . 1A M dE E i
ST GA Sl B W BT B AW s on ek ‘o
M R fewE <m R R afTel SeaaH ] Woomoon e
AP B W BT, AR Y| g, e e w ¥y »
P goard H WY A9 wEil AW e B
g <7 R W B A I B Lem g a4 w
: > fam 326 . @IS 157 T
T BE B AW W @ <
e €T (Filtering data) TR £ 1 3 EEEEE
fry 320 % R @ & BT § ok G WAl || Bame Clos Scescs Maths Erglidh Hodi ST TOTEL
Fad IREI-U  BET B 3@ @ TEN LT | o r & T
TSl {1 § % & ¥ w
il ' T B4 " 4 1 Fr &
T D forg ﬁ%ﬂ T WS B i m 4 & 2§ ¥ &
¢ ' 4] ] | 1] a ] 1] o]
Uh 3IY BRR B STINT R Ghdl & — Fhe o4 a ®u = P ¢ =
‘Filters’ | e — o ke
1 &y ' | -} d % {
- dfedr # feeey o B owwwr feger R § D § o8 1§
g forF 329 - rfdees Ser
1. ™% cd E”_\r. WX AutoFilter 3fzd i_}HII:;:':l:-“E'_kHI';;lan_;WtB;: lhly H'I'_%'I.'ﬂ'l'ﬂil
W fade B N s & w % % n =
2. I8 Ud IleM & IY W fheex - |
MG ST 6 fom 330 ¥ fewmmn lim #s ¥ 1 % & n =
TR . . o & & % & » m
3 ;?W oM & foy fheer W s e
| T T n n m i o Fes
4 SIO-SSA SH Bl B W Hedl B o 330 : e ¢ foy 77

Te g s e, SeRRe @ forg,

FETT XII-A 3R XII-B
5. fewice ®U q 9 AFT B Sirg Pl
Ol ® a7 ST Rielae fbar omar 2

YA R HAR YR diere -



By L] 5}
i Mame - IChasd -] E-cl.hﬂv Maths| - | Enq
I Wk Roy Bﬂ
i Crabe et Burwechng e
i Aeuie Sl [Damenradrgg uiy
5 EEnw = K
u Dy T 500 1
T IPEnE Uty hr
§ Ghictar Blat Ly =
o Farcn B8
W Amshil i fasd fodom dif
11 [fdani L
1 Beema ]
T
] Fel o A
4
57
ik
i
2
‘3 ]
13
= i o
M
£
4 [ Lanced [
faT 331 - FET XA B fctae Foar
o e e e
ulp.-.|aa‘ - F. L o OGRS g 7 B
e e AT L AES = BN T Tl
h In s !
[T e 1 | ' ‘wymr v
Kame, 'mu: il:u-: H.l.l.h T {=iTOTHL -
.'l*a.l-\, TRk ] B e =] a
] ek n ] ol =
. ik B - Tl Ly
e iy e =~
pr— A ! i “ =
] Fewicr S
‘_' r-lﬂ.--l. ‘_._:
a7 333 : Vi?@'?ﬁz 7 gver vl
Protect Docurment >
Password {npti-unaly
Password: ssssses

o, {

(The password can be empty)

Confirm:

OK Cancel

Help

a7 334 : SlFGHC SHRIGIT FIF F GIUT TG

60

6. IT AU Had P XI-A I Bl @
ST TEET AEd 8, d BET XII-B @I
IFE P o fb R 331 d fowmr
T 2|

7. OK R f&dd & |

8. BT XII-A ¥ ad BIA &I el o
332 ® fewmr w2

i Il_ I:In1 - Relomas - Math -

l.“-!!ﬂl Hinadl | n'T 'I-'ﬂ"ﬂ-l'-
1

A e WA 1 " [ ] ] ik}
1 SRk i h W :. 1] L] L

= ey - b e i 5 =3

e id 1] n L] Fu B

T L [ (o] H = i 187

e aia *® " 1] 1 ai T

faF 332 : feey 137 7T Se7

TRNae @ O Wedic @ R &Rl

(Protecting spreadsheet with
password)

afe g T o Rl R waRar & a
HRYCY WM IR @ T A g8 AU Sl Dl

[RET FAT AEH §| 9 T oA & @E ek

gd IR ST IM H d5A@ | 9§ IdS

B SEN WG AT VST I Gl o

W PR GHAl ¢l BSYic @ GRel @ folg

T §F YR 2|

1. Tools W fdo® o IR fF 333 #
fegmy JAJHR  Protect Spreadsheet
Rietae v |

2. Protect Document S didd fd
334 # fe@mr )

3. password CIgU N |

4. Confirm textbox H Udh &l URIaS

TZY PN |

5. OK W fdaid &V |

6. 3, W MY BIgd Bl Jallol b @
IR 39 fy 9§ AT R B Al IS
UNde @ forg | 39 UNaS Bl
e Y dIfd AT Bl B 3MTH IX

qD |

AR P — BT 12



gedfle @ e I U@ AR a1 39 YIR B
1. File, 3R ﬁv_\’ Save As TR fdald Elﬁl
2. 9 335 WWWﬁSaveAs@'&?ﬁ"T

df fe@rg < |

+ o hElT s Perdop

Via s < [ETTTETEE

Lrew m by CTE g bieed | rohi

v B ok trew | | wawd
faF 335 : Save As SITHIT FIFT

3. Blgd BL| clsu R IR Save with password
R s o |

4. Save W fdad & |

5. Set Password S dfeq fod 336 ¥ fewmn
T T

Zink Framavasore]

Fille Finawygataon Poasssaniil

Frnifer masswoiril T aaeen

Coritarm password

Pltor: A re @ posswnorcd s e Sl The Booirrost wall s

ey with the posseord. Should you fose T pasdsnd.
iheee will beo o wamy i reeoneed s clioourmennt. Poase slon

rraim bhal this password s ooy senmiknva

[Fow || G
a7 336 . Greas ST §IFT e &Y

6. U8l cRcdlad H Udh UNde <y &, 3R fiw
I UGS B Confirm CcRCAR H TIZY
|

7.0K R fddd & |

8. 39, W 3MU BIsc] Bl 3MTT R B DT B
g o' UM @ forv gp ook fe faa 337
¥ femmr mr 2

0. TNIge <Tl3U N 3R OK W fdadd &Y |

1| Lipbmnn

YA R HAR YR diere

Bt Pascswed x
Erides pas apen fie

fibes T L F5 cral/ Dk bapy Shadenty Marheels oos
aaaaaaa q

Help 0K | Canaal

a7 357 . BIgel 9T BV & forw
qreaE gev ay

61



62

http://www.psscive.ac.in/ Employability_Skills.html UX s‘—?ﬁﬂ o
W o T S faual @& difsar iR i wfve @l
3T @ PR W, R Tiafaf o)

e & IRMAS Tffaf

IR R AT B fb BH W H Wl @ 9w @l
AR 87

TARG 99 3

TR & D0 TA B, TR ART U B b foU I TS
AT |

Tferfafer 1

Hgm el | o 1 # feE MU aeR o wiiie @

[ kI= !
| Sl A B i o i - G|
1 §ol Mo, Wama Ergish  Hind Maths GSomope  Toinl |
[ Abliag Shas B T 56 Ky 26
| Anily Sohie TH T a7 15 a1
i i B gt Kiamar iy ] G qa 233
! 5 M Sulhi Shegr iy s ]!} B “;f-':ug
| .‘ Pris Trdwee | Té 11} 15 a1
| 7% Cmitam Cak &8 45 ] il .=:'|:
faF 1 T 1 T
®. g dBfcud T
1. ST B AC B & foly MU fbq # Aoy &1 IWIAT Bxl?
@) = (@) ser
(m) wfic @)=

) flheer gerg o (@) a7 Wi
() RIS BT JUIRT HY (&) ST Hife I
RIGFTR el — e 12



3. 41 Al o WEAINl & W (U BRI H $YCR WIE d¥d
g1 9 I8 gHRad & dEdl & 6 3z A 99 R/ s
B 7 W O PP W WG T| S A A AMSY?

(®) PUdle H YR Bl dlld BN

(@) 3T FYLR FT UMTS qacl dlich Pbly SHBI SUART 7 IR T
(M) foxiia a1 o W uae TelE

@) & & vie ¢ R g & 5 P W A @rerm

3999 B [ BN & 91G, MY IE G A Fed gl
o ST AR BT
o flheex TS oA

o UNIde & I W Pl YIcde i |

AU BE B e G GHS dedl g1 A Al o
Bl T SUG & BM D IRAT HAl dlRd & AR S GAA
YAy 3o
W

Sl

R U6 @AM o dRd gl 1 W dFl @l

qﬂqumaﬁxﬂww%lamﬁrﬁaﬂﬁmgﬁﬂw
g

I PR 3R USICIE WIERR BT SYAN
D Uh fSfied T a1 Wad € |

fSited IoiceM @ 991 @ fou UoicsM WifedR &1 s
wU W IR fbar O @7 §| §9h by GBS &, Ol $9 UBR 3|

1. 7 oo B ®ife S99 o fom, difswr, timem ok & fa
S faRyad 2|
2. fSfoted UoiceM # 9qcld v IH B

3. Ue fefSed Uuice™ &l M W Yiee #xed 9gd R SWdl 6l
feran S wadr 2|

4. goiced @1 fie 3R <ol @1 faaRa fear o wear 2|
1 (o B T R R S O S [

B3 Uuicyd WHUedIN SUde] & o fh

1. forg afifhg gwIg
2. HIEHNUe Ifhd — UrR@Ize

AT IR IR UENfia! drerd




.........

/%5'338 @) a7 177?1777777‘ o /%ﬁ‘
JiHT 38T @B Riciae &Y

64

4. T WSS
5. T B
o7 o GiveRRl § afderyr favya wue g gw
3 T H UolceE W @ fou fow offhw 3EM W
T IR ST N R®ifG I TH Wdd IR A
TR ¢ |

fors aiifhe m R P %I'Q TR (Steps to start

LibreOffice Impress)

1. ¥ Ugel, AUB! I§ GEReEd wRAr B8 G for
At SR AMUS B W Il T

2. fder & w4 dR # foreR i $WN' ‘LibreOffice
Impress’ CIg¥ G

3. Wd URUM ¥ LibreOffice Impress &I Rctde o

S f6 R 338 (@) W Ofewmr mm R

LibreOffice Impress 3T B U ‘Select a

template’@ﬂ?ﬁ"T 3T DI DA BN |

5. Uh @lell Yoice™ 3N+ g (R 338 (&) |

e

W A S P - BT T-HLe
e R B OREE B

Click to add Title

: Click o add Tex

faF 338 () 39T g 3BT FB

Tofcyd # TRE TS @Rl (Adding text to a
presentation)

fShicc ®U A, gl Wigs ¥ < RS g B B
9 Ted @ fou € R N fAww & forw fmen
(@SN U | 89 <ed dfed W e a% Ghd ¢ 3R
clsedl H TRY X 9dhd 3l U N8 8 fEe e
R fFdd &R Ghd & IR P H fdRUT Bl Y @R
T £ oNT f R 330 F fear W R

AR P — BT 12



F 4
#
WATER CYCLE

| a3 Gre: e e Shepa i wWake Oy
i L. BN iRl
! 2 Crared pn sl

A, Frac sl b

R 339 U wigE A e U8 av
39 e, & UNcyd 99F & fou fol Sy 3H™ @1 SWN g%

PR Thd B
PIRIR ok I
http:/ /www.psscive.ac.in/ Employability_Skills.html UX g—?’rﬁﬂ A XA
| 399 SWIad favdl &1 P IR - e erf | §—af T @
IR W, fFrferRad Tfafafdy o9 |
A @ URfAe wfafafd
AT I Yoide Y g1 87
RIS W I
Ty & o9 T B 9@ fORT U @A b folu §—aAf

e ¥ R |
Tfafafey 1

TE N

forsl afhy 38 H Uoice™ g9

MaeTS AERET

Ud, Aicg®, fol offfhd 9™ dTell $Wex 3N |

fshar

o TYR B T B IR W, Bel B Al # fonid w|

o Udh dilex T, Wl TR &I MERE v

o ﬁ*l—g[ Sﬁfﬁﬂ? m Fﬂé ?5% 3ﬁ_\’ ClgCcl ‘Advantages of using the
Internet’ & W1 Udh '_‘|_S'g( PR EHT(”

(@) 7 IR (@) 78 Stapic
() UoieTH HiredaR (5) wrede
AT IR IR UENfia! drerd

65



faa 340 . Save As’ ST T

66

| fTER 2

2.@?:[ Impress?ﬁ WW‘#QTW%EE%QW

AU Y W T il BRAT BT
(®) T (@) "rEpTe Jifthd
(m) fersaiite (8) TUe SEITa
3. fore 3fh 38 @ Ugell Wiigs H fhad eRe
T fehlee gRT U8 9 81 2°?
(@) 2
@) 4

U9 @ QX 8M @ 918, AT Ig B | Fe Bl
o fefca USiceM & o™i &1 quiH & |
o fAf=T Uoiced WitcdX & gl 95|
o UGICYH B FAl b BRR|
o Y UYSICTH M|

AU PR, delld

T AR

494

%ﬁrfﬂ
%/gj/.
%33
2§
2)
=

Has

1. File R fdcld 9|

2. @’U—W U Save As J1 Save @ Ricidc & |
78 fod 340 # fR@U U AR save As
SN a1 fevel axal 2|

IT Th Blesy & Riojde &N Tbd @ olgl
AT Bl Bl VT AT Ied 8, AR b folv

Desktop

w

AR P — BT 12



4. folee ®U W, BIgd BT AW Untitled#’ (# U6 AT 8) €1 M0
39 AU T b AW W 98 Idhd & |

5.%‘??—7?6 U H save As type .ods 2| 3 Save As type W—W
T I BRI YBRI B Riddee PR Fhd 8| MY BIRA Bl MS
Excel I1 HTML IT CRT BI5d & ®U H U9 God 2 |

6. Save W fdold Eﬁil
SH B W USICY Bl Ha AT A | 98 H FM I G,

AT YICTE B g B B folU Dldle W File>Save W fdaid T

Ctrl+s U9 X 9ad 2 |

UoICYM &l e B @ folg WO (Steps to [save Documentt T

close a presentation) J\ Savm changes to docmant “Water Cyclaady” before
forsfl USICe @I T dR & RO AR | S asing!
é- | . : Your dhengiy witl ber st if you don'L seve them
1. File R fddd | :

> : 5 Dot Sews Cancel
2. M-S A Close Ricide & | | [

3. I MU WA B FANT PR U o 341 - 7 SiwHE SITET ST
gRacy 99 7el {6y & a1 98 mal fe@mn
RN 7 341 @ IR ‘Save Document?’
ST S & W Wod | AW qd
TR Fhd & b AT T PXAT AR & AT

! .
HF BT TRd ¢

YOIy MU &R B ﬁ”m IO (Steps to open
a presentation)

UOiCTM 3T @R & RO (AR B |

1. forl 3ifh SR 31U &Y

File R f&e & |

. W,@U—WQOPenW N | . .
. 3" Open SIUAN dfdd fowl BT R e

o5 R 342 # fewmr wam 2|

& W N

1T Desktop a7 342 : 3197 ST T
6. R Bzl Riclde &, ST & foru

diex T3t |
7. Open R [ddI® |
8. W%ﬁmmﬁ‘\)\/ater

Cycle.ods’ 3T BT |

AT IR IR UENfia! drerd o



68

Yoiced fiie & & forg =mor

Y TS &6 o R wEA @ fic dW @ WM @R, U
R & @ i a9 ¥ 991 T Wﬁffmﬁ—daﬂﬁzﬁ

RO TR B |

1. File R i@ R

N

SU-SS9 ¥ Print Rioldc & I M0 dEls W Ctrl+p U &%
NE

Print SAN a9 fevl Bl 2|

B ¥ g UH fiex SEan dfew # v B 2

S Ul @ W Ridde W R o fiic exr aed 2

All Rl & IR o o wgs fie a=a1 aEd 2

Slides ffelae aX, AT MU ST ¥ §B @ filc &= a=d 2 3R
%hES FR YIH $RAT ded & |

OK W fddd |

N o gk~ w

©

http:/ /www.psscive.ac.in/ Employability_Skills.html UX g—?’rﬁﬂ A A
o3| 39 SWIg fawal &1 difedr ok s—arf e eRfi| §—af T @
IR W, FrferRad Tfafafy o |

TS TR T

TR $T DA FAT 8, STBT fART U B b ol S—dfT TS
B

Tfafafer 1
e AX
forsl ST SUSH H TP Uoiced W HTH e |
aTaH AR
fors offfth g2, U4, icqd scdla & W1 HRYCX |
fshar
o DY I AR B JMR W, Bl Bl Gl H fIRId awR |
UG T MefeiRad Tifafr o |
‘Water Cycle Project’ 1H q Udh Uoic e Whlgcl qT W
- B FANT B
- R R 9 T B
- Juiced fife &
o YARFT B & TE & UAd BE & B4 4 $F Ud AR
T BN HiGT Aol | 30 9 <@ Wdd © SR @ Wel &7
W B T o SR T [uR fRAr ST Wadl € 9 39 W
gfifen € |9ad B |

AR P — BT 12



®. 9 ddfcqd Yo
1. fodfl USICeH & G o B foly el WU DI A &

(?5) File>Save As>Type file name>Save
(@) File>Open>File name>Open

(W) File>Template>Save as Template
(&) File>Close>Save>OK

2. B USiee™ &l Fael R & folu W&l aROT BiF AT 2

(55) File>Save As>Type file name>Save (@) File>Exit

() File>Close (®) File>Export

3. Uoiced file &% & fofv Wl =T S WAl &
(35) File>Print (@) File>Print>Handout
() File>Print>Handout>OK (8) File>OK

3999 @ QX &M & 918, MY Ig HRA | 6 Bl
YOIy Bl AT HRAT

UG BT Felll beel

USICI Bl 3T HRAT

UOicyH TWiigs & e &

A T D A e e AR B
9 RIBT @R 9ad 21 AU ' <@ {6 g S Ueicyd
e g HY T GHd 2 |
Tolcyd # g TS oAl (Adding slide to a presentation)
g T A Ugell wWige H dick WRfhd @ Wi AW WOl B qheE
fhar| 39, 98 TP W B ARAT PRAT el 8| offpd T U9 W
IF BRI STl BT 8l T AW Re Teds & OfU, 3R
7ed IR WS H qRGA BN |
gHll T SN TP 5 WSS Gile ahdl §| Wieed AU Ul Bl a¥E
g, g orom—are fawal @ wfie & & fov te Uoicyd § Srel
ST 21 ol Tl ARy, §eed SR a9l @ ol uRe wWes @l
Wie 9adl g, R T3¢ fOvy 9 Ged O I -3feT ¥oligsi A
IE AR T Fodl 21 T2 Wgs oed @ fog, FF aRf @R

=+

AT IR IR UENfia! drerd




a7 343 . 7 &S U5 PYAl

|-: e Uy oedp - bt e I

Fle R Tew Bued hoimel e PabeShhva fooll Bindow  Help
3@ A 4
el Shedi [voim e
| % -_Ii"'l__ F R Duplos lde
Hidec o - [ i
Sagmvury Shda

Esmanil Sk

70

Slide W f&Id & |

U SS9 9 New Slide Ricide &

o f o 343 ® e w2

3. 3 PEle W Ctrl+M W T Tohd
g

4, I8 YoicTH & [l Th R Az wige
TS X T

5. CRcAlGT 3T &I oliSe T gawel
ot & 9= Bnfl|

wEed @ fSclic AT (Deleting slides)

Rl wee @ feflc &1 & |0
R €|

1. 9 WEs & Ricde &% /9 am

fSefie ox1 @’ &)

Slide W f&Id & |

SIS ¥ Delete Slide Ricide &

o f6 fo 344 ® fommy w2

. e oy W WS fedie |

I Reide fdv T wizs @ fSoiie
A b U P W Del’ 1 UH
PR Fhd 2|

CRT TS Il 3R WA & (Adding

and formatting text)

fors 3fhg 3B Wiss & fehiee oldee

i Q CRed™ B - U6 e @ forv

AR T RS @ folU| MU a9 DS

R TRY NP SR TS BY G ¢ |

IT qUe I TE Wiell WES B A

TRCATR el % ar 3 Insert>Textbox

3@ BT SUIN IR Udh TR U dY

Thd & o fb e 345 § fewmr w2

3Mg el 1 AMHR FT I8 CRedIdT g1 Fohdl

g, 3R fhe, TR Tev |

N —

w N

(ST

o ] [
Forrmiast ng Tl '”'_‘ - a|
i |
faF 345 . BT ST
AR PIIA — FEll 12



Wﬁﬂﬂu\ﬂ'waﬁqswmwwzﬁmmmaﬁ
tmﬁe Fhd |
RE B REE o0 & W @l dgod @ oIt 35 Bie wWsd
ST 8| UH ST ¥l Relde &3 & ol Font Style SiU—SST
Wﬁﬂzﬁammé?ﬂzf?ﬁ%@aﬁ?maﬁwww(ﬁaa
45) |
3T Font Size $U-SBT W fddd b e & Agdl 9 dgd
Thd & IR WRW Rieldc o) Fdhd & (ST @ foly, 8, 12, 14, 22
;ﬂf}lmmﬁ%mmm%mﬁssﬁmﬁ@mw
|
TRARCT TRE — dles, JISRASH, 3ciod (Highlighting text — bold,
underline, italic)
fors ofifhd § fefl CRe @1 BISollse &4 & folU, 3T 3Madhal &
IR W 3 dles, evallsd IT sefofd a1 dhd 2 |
U Ugd, 99 R @ folde B O gEalge ovl gl Y
Properties g H ﬁ'ﬂ’ MU 3Tghd W ﬁﬂ—\’ Elﬁ o fb R 346 ®
fomrr mar | 9fPd BRM B B AU MaRe Agdd &1 Riddde
N, JAT, U dles, 3lold, XA AT WRGY I |

ALIGN TEXT ._:-" - o
Align Text - Left ™ e
Align Text - Center LB LWy “apd
Align Texi - Right | , : -::1: . 2
Align Text - Justified ¥ i §ems
| P 346 : GIEAFT e

CRT TG HRT — olUc, IgC, WKy, JIRCWISS (Aligning text — left,
right, center, justified)

TRT B T, 5T, Wex T WRCHTS fGIm bl 2| Properties 8 ¥
Paragraph 3[®F & SUAN &xd gU ol [ foF 347 H fewmn
T B, TRT Pl Vg BT W \ahdl 2|

Farmating Tex1

Formatting Text - Bold

3% §n

Formatting Texl - italic P
| Farmatting Text - Underline |== TE
Formatting Text — Strikethrough .

E

a7 347 : 2PC B TAlgT BV

AT IR IR UENfia! drerd

71



72

ATE T SC TeaigT @l 4 2 fh SRe HAY: ofe AT Wge difor d TeligH
T S| Hew Tlgd Ud & dex H TRE Pl Tollg dudl 2| ‘SRShIg
CRT DI NI5C 3N oI AT W Tells &l & |
TRT P Bk 98l (Changing text colour)
T CRT B JAM—ITT HeR oI Yoicyd & R N foeeg &
qad B

BiT HeR SII—<rS A= ®HeR qal & | | 3 CRE &l BeR g
|qahd g AR fod 348 # AW 3FMR 98 Wad § | Font Color 038 &
37T, Highlight Color $IU—SIS 2 | I MY EESe HoR SU—<rsd 3
fHdl BeR BT Rielde IR 8, A I8 RS BT IHUTSS R d8cl < |

Frape a1

s

Evaporation Set al
: drying up of water from the lakes e
storccoo oo tho closan oo |

[T 348 : CHCT HeI? T
<9 TRE, 3T YoicTH Bl dd AR Gdd a7 T ¢ |

http: / /www.psscive.ac.in/ Employability_Skills.html TR $—alf"{ o\ 3
| 39 SR fawa @1 difsar ok el wfta gff| $—afT @
IR W, fA=ferRaa Tfafafer & |

TS TE 3N

TR B &9 I B, 9B AR U dRd b folu 3—af+T Ure
T W

Tfifafer 1
TE A
Bic Wed & AT BM G ford by S99 § <Y Al
AaTTH AR
forsl offfhe goM, Aleq®, U9 e & A P |
fshar
o TR P GG F MR W HeT B A H PN | IS
W frfafga Tfafafrr s
1. Y WIBE 3HC MY
2. fors offfh S8 <18 o |
3. Bfe & M9 I9 H 98 |
4. TRC Bl AHE HoR T |
5. JPUTSS Bl HeR YT B |

AR P — BT 12



6. TR Bl ford 1 ¥ fow@mn ST A1feu |
7. 39, ‘Google’. clgy ﬁl
Google
CERR//cl A C
8. ‘Bookman Old Style’ EF} f%’l'(f tb—\lJTCr EE?H
9. WSS Bl 54 ¥ ool |
10.1%1321#%_?1@31@25#@?&3?{

sl a: ; Efapoiamin

faz 2 : 7.7.7-%737‘5?775772

R & b T & UAd BE d I8 QAR HA G HlDl
fel| o We® °@ Wahd © AR I WE T U fbar T oo 3R
R GER BT ST Fabar & W URHAT T W6 @

®. 9 ddfcqd T

1. WES oM @ fou oM fog # sffeM &1 STM axd 27
(@) gfee
(@) g8
(m) wEs

(&) gou
2. mmaﬁ? R, WES & WG title DI DA TG HuI?

73



a7 350 : ggdtor 29 @ Gy
YT

74

3999 @ QX &M & 918, AT Ig HRA | 6 Bl
o Uuicyd & ol TIgS TS Al
o Uuicyd ¥ Wiiss fScile dvAl
o UUICYM # SR Tex 3N Ufee vl
o UUicyF ¥ THRT BIHC o]

fSfiled Uoicym § SWF @l W den i S=a
g §1 Whad, A AR THS BT SUAN USicId @l
IR e ARiE §91 Fohdr B

Yuiced GTI'Cfﬁl?ﬁ Gl 3'\'4?‘.; Cagll (Inserting shapes in
presentation)

AT Yoicyd H Uh UhA b YA @ foum @ fou W
B STN HRAT 1€ Fhd 8| Seexv & foy, afe am
I8 fommr aed € 6 aer wEfed $9 oM X1 8 —
AU W B ST &R qhd & ford offhy 3 wg @
AGT Y IRAT &, o [ ollgd, WRR, |idd, W,
Ryrer anfe, 2 wiigs # 89 fhdr o Gdhar 2|

Waler Cycle

Condersaiion

Frecpiaton Evaposation

a7 349 . FAEE 7 HhT §FC B

o 6 R 349 A R 1 8 W 98 & @
fog, aMusl $9¢ W faded dw BN, AR TR, Sgfd @t
Ridde o | 8 @3 o 2| N voR @&
@ B fow WO | Uolev M @ fow emawa v @
Rrcrae Elﬁ IR B f%l(’ ‘Circular Arrow’| $9 dNg,
AU AU FWAR bl 1 o @ Rfelde R Fabd
g |

Th R U ®MEe § U6 APl 39 oxd & dlg,
3T Properties ¢4 & SUIN X I & U A
ORad #X FdEd T, o Hor, Argw, Refa, feum, anfe |

AR P — BT 12



1. ¥ ¥ Insert W fddd &V |
2. Image Ricide @ oW f& o 351 H

fegrar I 2| T —————
3. T 352 # fewamw JJIR Uh Insert Image ] DiomalhaB ki
ST dfeg foxars 2| S W EErED
N . . jt| Eracha o Wik
4. Ploskl D AEAH W ARG BN AR S T [ =
1 Riclge & e A ST =l i LR
e & | . b
- [—— -
L W
3 - ' 8
¥ [k arvem
i, B
il Ol s R
- o
s & fas
i i il b s [ i e
o 3.52 : TG SN dfad AT By
5. Open W [ddld N |
9 RE M7 Tl UuicyH wige # R g9 N 9dhd @ R 9
AR e Jed I Ghd ¢
Water Cycle
Conoensaiion
FrEﬂI[:l_ILE__I,‘:IL'_rH E'._ff':u_:_::l_ra'rh:-n_
A7 353 wiise § 87 g6 B
A R AR e s

L T

¥

fer 351 : gl Bl Riciae oY

£



)
-
1 Pl

BYIES] TS qgAT (Changing slide layout)

fors SfifPd 38N Yiigs & fSWlec dSe H cged @ folv Uah 3R
T & U U6 TRedldd BT &1 ol Ifed T 9 WSS
Al @ FaRed @ H AGS IRl T AU EWddl & TR
WES ooMSe & gl Idhd 2 |

I AU Th WG U b TGh Pl Th gAY gdC Bl dRd & 3N
TR W W 3 &, MU U6 CEed 3R 3 99 & 9 Udh claee
B Riofde TR Tod &1 T 30 ddd &Wlgs & Rode IRD B

fa7 354 . &@378C |ad § AR R, SCH <d Y AP oS B Relde dRa ol
ey & @ivd  f& fud 354 H fewmn w21 demse BN ¥ 9l @ aifvd @
dI9e @ Riel7e [ U @) W "eg el 2

76

http: / /www.psscive.ac.in/ Employability_Skills.html TR $—(7 ¥ I
BN | THH SRIGT vt @ AT R s wmiAe  f | ST B
IR W, FA=faRad Tfafafdy o |

RIS WE T

T & D9 I T, 3BT AR T dRA @ v I Ure
W

Tfafafer 1
TR I
forsl o S # Ised @ AT B Bl
99 : 20 faee
aTH AR
fors Sfffhe 39N, Alcg®, U9 3T & | $HREX |
feham

o YR P G B JMR W, BE I Gl A ROK B
Te T e e B

— W3S @ oldlSe @ TlRed 3R aR Activity
Tl W) e B «;"‘?

— TE AR T AT MBI BT g 5
R, AR B oY, R AR S[THS 'f'"ﬁf

— TR IR VR IR IAAS @I I T |
— Ul ¥ge fRE 1A RU W d WEWW AT o7 WA 1 75w
feere < =feu|
gHEd X & T & Ue BF & T W I (& B G
@ bl el Y FG® @ Fhd § AR R FE T 9 (bl
T AT AR RN YR BT S Whal 8 W OURIEHA < Wad © |

AR P — BT 12



“sﬂ

3.

CHENE)

ufee
BN
Joicsd H Td ddR I 39 BN B (oIl &1 hed &7
@)

@) Tools > Shape> Line> Square

)

’J) Format > Text > Basic> Square
mmmméwwﬁ%aﬁwsﬁ%‘?
) TRT BT B gl @

(@) q S

() WAl (e, $, W) B gR 99dl ol ®
(6) TRcd wge & WX ¥ Udisd @l ol ©

Insert > Shape> Line> Square

Insert > Shape> Basic > Square

o~~~ —~

E)

39 D [ M @ 918, Y IT PXA A G B
IR IHAC BAT
fde amd 3R gHW SO Bl

gS ol3Se g8l

https://edu.gcfglobal.org/en/powerpoint2016/inserting-pictures/1/
https:/ /www.gcflearnfree.org/excel2016/getting-started-with-excel/ 1/

https:/ /www.webucator.com/tutorial /learn-microsoft-excel /entering-
data-microsoft-excel-worksheets.cfm

https:/ /www.gcflearnfree.org/excel2013 /formatting-cells/1/
https:/ /www.youtube.com/watch?v=sdqfvgD_qMI
https://edu.gcfglobal.org/en/excel2013/filtering-data/ 1/

https://edu.gcfglobal.org/en/powerpoint2016/creating-and-opening-
presentations/1/

https://edu.gcfglobal.org/en/powerpoint2007 /viewing-and-printing-
slides/1/
https://edu.gcfglobal.org/en/powerpointxp/formatting-text/1/

AT IR IR UENfia! drerd

77



STl Td AR B TN B, O geM, Yol Jer SR S,
gfsharenl @R Wanll @ fov U IR Wied A1 90 AUR H_A & forg
IReferd IRgH SN & fov U6 FaER @ Ugd™ &vd 3 |

Safar faers WRfod e ok WM i $RigE & AeIE |
Semeledal B9 R IF Bl deM @ WAl P Wefd bRal 2|
TEH U Fldd W M dfad AT F@T B, W AUR YR BRAT AT
SO@ET IR o)l dEal 81 8MER SufMdl @ Ume &R SHe
[ foly AT Hied AR WeTd b wU H WA BRA DI MIIIDRAT
g1 Uh Sufar e ey & 39 R ¥ fousd fear o
m%wmﬁﬁ?ﬂﬁﬂqﬁﬁmsﬁ?mwuiﬁwmma%ﬁ@WEﬁ
R TR

YA & [l IR$ B Sl JaeIdbdl & ol @ |

Safiar e § uftemr & fou 9wels wfid oxd @ smawddT B —
(aﬁ)wmﬂama&rﬁmmsﬁqm()amsﬁmﬁwm
IR IR GREPI0) Th qR & Ja/R $I UgaMH AR S G
o fou domEl & FaRyd &xe & fou mawd g R (1) R g

ﬁpi%\



IR yfawel & fou e yewE| dWifdd Samdl @l Sud @ fewuh
el JAAWHAT S FAEl, WOM Al W ST Bl I DI &,
Ul & U AR AR emar & yaifdd R H o weg faerdt 2

A JUMAT T Y ANR HM HRE e e sk Sefidr
TG, WRA WAR &1 Uh Y9@ W67 ©, ol IaWl AR BRI
ffera @ ggar <1 @ fog gl Wl iR orEuM # ded g
WeE @y TR # el @l ydes foes eriwe,
SUNT—He-aIad A $RpHd, Iafd fde dRisH 3R ey
TR e |

R B | B IRl @ URWING &_dl &, “TM-I9d SR
Bl ARY G, Y @A SR IJF AWM M B folU TH I
wTfcrfafer |

WIgq 3R SRl STl & 39 wU H IR &=d © : "d8 ufhar
g gR1 @fdd S WOEAl & Fag H JfAER| B U dRd ©
e 7 adaq & fefa o €1

39 UBR, el & “Ua onii@ ufhar, W'l U6 fduR @ g

I Th AGER AT el 8, o uRepd, e ok drifad fdar
Al B, Wdih GAEAl @ TG SUAN ERT AM Bl HIBR  EHRA
forg sfRead & due ¥ w1 @ wu A uRafid e o

FAlde e Uh SeHl Bl Uh Wfdd & WU H GRWING $Rd 8, S 3
AR W U& AACEe 9 §RT WAl Bl © ol §B Qo= d
$%91 a1 vl g |

TS U Afdd & WU H Ueh Sgd &l oRWild wxa & e
dRT 9 aEoe Rufd RuiRg eidl 8 iR 9mifve e & ameE
fiyerar 21

79 IR P — F&T 12



SerefierdT e

ygeH O Udh SeMl B Udh @fdd & w9 A URWIfd @xar g
foraes o% U6 R g B AR W U B B fov E e
ASHT T 2 |

STl @ &Y Characteristics of entrepreneurship
g IR & SR W Semeiiad @ §B fewan fefaRad )

e YT TP AMPG NN T W AM-SHE W6 M, faehia
A AR e W & fog @ ol 2

e YT GOR H [P oA AR AW BHAM B oY TH faER DI
TETH TR b A YH B B

o T GIRAI & SWN H IdHed W 6 |

. JE RN oW & foly U SEM R TS e @ e g

Safd — @ IR fagM Entrepreneurship — art and

STHA B U6 Gl AR UH fag qMl A S g fedr fawg
Pl 9 & ®U H A @ foly, W wERA fOgE A Hifder o
q YAV b gRT UH AR 9

5
54
53
i
5939
=
|
3
3
s
:

e

27
|
:
=

=4}
7
7
3

3]
S
4w
«d
o4
(65
2|
A
Al

g
4
;

1) P o
ﬂﬁlx
g 231

80



U6 9hd Sl P fI9NdU Qualities of a successful fewofy
entrepreneur

MU 3@ I W W AR W W e Sl B Ahd T g
U oM B GhAddd daM & [ F3 O DI SEHAT B
Al 2| grelfe, fEfaRad o @ SWe fory Ae@qel AT
gl

(®) UES Initiative : IR & M1 ¥ 3w 3 § SR o
g TS ST Bl IR YW D AR TP AR BT M
oM H WgM B AUl UG R o9 By @fdd (ol
JIW W I& ol @ d 98 IERT e M Fhdl 3|
2qferT, Sel B 3R W Ugd BRAT IS 2 |

( )\_rﬁ%lq A @I T Willingness to take risks : ol
MOR A SR P TH T W B g e W ¥ B

(M oqwa ¥ ¥@q @ &Fd Ability to learn from
experience : ¢ STH Tafdl @x Fhdl g FTclifd, Th
CINE | O 1 | A )| e B | 1 R ol
AT T TN F@fG T AR JHAE @ Fad 2| g9,
AT & U WA W AW B ewar g9 ARy

(1) IROT Motivation : Sdd & TS &3 H Thod@l & forw
IT IAEE 2| 99 AU FY I @ fog IR & AW E,
AT I [ R qE AIRM AE G| ISR D fer,
FH—F, 3T fll P A7 ufFer B UgH H sad o &
ST g el SW W R db Aiq del S| dM H
T OWE D OBA W B M W 2| Thd Se
T 3 ol I8 UF Aawd 0 T |

(€) ARG Self-confidence : Wldd H WhHodl W IxRA &
fory, wfdm & o oM # oTcHfdTaN €N amey| fawd A

8l AR BT — BT 12



SerefierdT e

He! ASTd Hard work : Wldd ¥ &gl Fgad @
T 2| ANR TN GG, T AR AT R W
&l qdd BT BN e GEwe @l

@)

FM ol de’ o Rl
XAl U8 9dHal &) 39 UOR, el
ST B U o @1 |W B
@ &9d] Decision making ability : Ud 3gH
qAM H, Th SeHl I Hy (UG oY B B SAfeY, Afd @
Sfd R W MU o # e g @Ryl qddM g
Al 9gd dell W M gedl §1 AR fedl SEMl @ UM

A

FACE B TP IR ABGR & A9, AFaR ®Y W

T Pl YicAIRd PR H WeM g



U SEnfie Sedl sffad wu @, ve Al g € O Uigel @
SeRdl @I UgdM dXdl @ 3R SHB Al b v Sdrg A7 WA
L S goldciig SEl, BUS]

T
A
&
-
=
4
E)
512

83

AR T — B 12



Wwé’f@ﬁﬁﬁ*l

al
Gl
w

S 6 AWM W Uar deldl ® OW Afda Sgfar SER €,
I Afee ST BE WAl 2| By AR SeMl  Semwierdr
Tfafdfeal ®1 I FE H UBA PR @ ¢ AR S H Fy o

Y w f ogar Rar 2

I°K¢
0
el
kil
E2

fafe

IR
SRR
GRED

SIS
ﬁ?w

PRTIT PRA 2| AR gAY I BT &I ATHID
& 9 WER SUAN fhar S 2

Bl AHAAYAS  FelTd]

ST B M dR

T, ST WA @1 oM UgAM ATl Ml WO i

T ¢ ST GEId SEH bl ol 2] 9 G,

R & fou CRd TRl B fefyd, A

B E"
it

84

SerefierdT e



Udh SEEl @l W 3R @R Roles and functions of an feaoft

entrepreneur

UG IJPHl ENT fhY T $B W@ PR 9 YBR T |

(@) SeMl SR @ USAM Identifying entrepreneurial
opportunity : IMUR &I ?gfaﬁﬂ ¥ B3 qAW Bl T WM,
bYH, Rem onfe okl AdRE SRwdl R OEIRG § Sl
AR 95 38 &l 31 @RI & M Ol gRI 7Heqd
el fhar S g1 dfdd e Sl Rl @ gor H ool
U IR BT AW IRAT | 9o, SEl @1 WG
ARG AR FF Gol W USd 7| Ub Afdd, A Sl gl
AR &, SHBI GHod], IIAHAGA IR TAAdT B Aaegdhd

gl B

(@) fdaRi @ far ¥ IS Turning ideas into action :
SeMl @ foOR @I aRafdedr # 9 H et 81 @Iy |
4 9NIR B AN B W AR b oy @RI, IRl SR
g @ gR H GMGN Uhd dxd H WeH BT ARy

() AT 3T Feasibility study : Sedl &l TRarfad
IAE AT JqAT D IR IIGRAT BT A X & fov
JTT BT A IRAT & d GEES BT AAA A @
dR TeM AWM & U SaWEd AL, U, AR 3R
ST @ Akl & Ahed B ©| 9 AR F UE
e 3 oo @ A1 Ui RUE & w9 H ST S
z|

(&) W™ Resourcing : Td AR Bl HWTTCTZF Uh  STHl
B TAM B fov gd, 79N, Fed AT IR BRIEA & WeH
¥ = SarEl @ dewedr B & SEM Bl e
IqaE B T W GARE B FH W ST

gfad & &

(@') SEM RIfud P Setting up an enterprise : 3YH wrfia
B B fog SEMl I FB BN TR BRI
PRAT TS WHAl Tl Add B T SUYHE IF @I,
IR @ oz oo, WA g o iR &3 3
B T B A PR e AR

85 AR BT — BT 12



@-

SerefierdT e

(@) TeEM @I Yd¥d Managing the enterprise : Ud
STH Bl TAMT 2| Afd
Wqéwméeﬁ?w
Wﬁm&ﬁzﬁwzﬁ‘rmﬁ%w%‘l
M) gAREd FH @b 96, @fdd
aﬁ?wzﬁrﬁwmsﬁmﬁl
e W YEfd @ed difsd R

Growth and development : Ud

W9 I difdd URUE U @R ol g, df
ST @ AT gfg R fem & vt ek
ST e B Udl Ul BT 8 Ak dad U
feiRT ded W a9 W Aqe T e g, dfed
IHEA T B B foly AR I Gl & |

Th Sl B @ IR HNal 2?7 What motivates an
entrepreneur?

Y% AFG $ WEE BT & 6 98 Fod I SR AW
ﬁﬁwﬁﬁwmﬁwwzﬁ%ﬁmé@ﬁ?
B T AfPT B ZAM BTN Bl G § e gl
B B TR AR, Uh S Afdd o Sewliad @ v
® W W M Al W OdEl B X BRI Dl EEdl 3R
3 YAl g1 Afed foxll 9 B W e AR et @
T G & R BT Gl Il 2|

frfifed g9 1 § 9w Sed @ ORa @ §

Th SeHl AR ST HHd [HuiRd
. IXAT § QIR Hel HEdd e 3R
o 10 T4l W gu Sl b WR Bl
U B BT TN bRl 2

e Sedl @ fou W wewget i
.\ .
: AT & AR R e 9 e S

g, 99 gy & e |

86



57 e =% i
WW E wWWWWMMWW

wmwm PEE: mmwwWWMﬁ
B 8 qwam R E
-fa w@ﬁﬁﬁ%ﬁﬁ@ﬁﬁw
CEEE ..WWWW$WWWW@WW
v g e e
& g Mﬁ»wm%wmwwmw
FETE ey I T
W$MW P e PRBE EEopsE
€k E Wmmmmew & -

AR T — B 12

ST AU W UR RA1Ud

i g8 Y ARl B DI B

U6 SRe o W@ oAl
3. Wl 99T @, 981 Wl @l AR T T IR oW © Al 89 oY

R @ A
W P Thd 2|
87

2.



—

FRIfT

Tafed Il & G U6 WE@qUl §aid 98 © o
Wl AR $ AR A T 8| 71 U ST dl U
WA W M Dfgd Bl AMRY? T STH Bl Td IR
AT S 1 WAl Bl AT BRAT AMRY AR FH GEN A
HT AIRY, o8 I8 SUAE Tel 8 Ghal 27

@@ Ne (6 gR Serll T Aawlie FaR @ wegH w

Tebcl aﬁqwa%aiwaﬁ?\ﬂllwmioulmdaﬂﬂﬁ%

FTER )

. '\':I'I'ﬂ?m WHR Community concerns 31T RECR ®

UGS el @ qoE B | FH-F, WHE T Y TH
TN oM B GhT B SREARl I UgdE @, fageryor

' Pl IR HH WGE IR Fhdl & SR ARGH &7 Hedide

i3

. 4
- N ¢

i%%i%

MG : G deA b dy Wlddwel fTAR ofgHal U

AR te Serll Sfiew # ARl @1 e aRar g1 afe

wﬁmﬁaﬁwmﬁ%aﬁa@wwﬁﬁ

A DHEAl Bl AN ALY AR OUROT o AR

el Sefier # wfdmench gae e @ed §
g

3
4

i

4554
SL%(’%
-
:
o

2
o33
1447
442 %

El
4 5

Uh SEdl @ folY, ¥E WE AR B YW HRA AR
BAM ATH & IR H | AP JHREU 1 ¥ b
aﬁﬂwzﬁqmizﬁwuwzﬁwwﬁim
1| STe WA @R q GHie ke @ o

AT, T A Wl BAgE & ARIH W IS gY B

EREE

si
=8

g
=g

@ f @ o El_é?ﬂ'q

l;.-f]-"l'mém

SerefierdT e

HHe

s U TCICOMT T U BT 8 O U9 Wdled & Ugel ax0T H
B B TP Wl ey ®U ¥ gfg @ IR H 9ed b dWa
¢ fou U UNURG AUR  TEE  H-I B Th

88



WY B JRN GIUHI gR foa qwor fvar o 8 o« TR
b 6 AUR #eM H 8 S ol g iR U S 3y S
Q] Q fod a1 Faw a2 e o 2

g 3 ol verfid wrde & aR H 9gd gd 2| W
Menfie], WReT GWTe, WIoi, 3MYRY aRafdddr e & &
§ g Gohal B, 3MEY B WU & IR H 3ifd Jwel |

o WM F Aad e & W Iw A 9 wEar g
aﬁ?wwémw@ﬁraﬂwaﬁ?éﬁ%w

s " e QTARTA7UP

IR B foly, 98 IR WICaU A IAFegd @ Ry
Y6 B Q1 &1 U Aolgd VU @ Hee W, 4 WriE W
YeTaRll A NNl @ W WRIEN eRd 8, AR HoM @l
g el § #eg o 2|

. WICHU WG B ANRI &I ol H e ¥ i
faer aed €1 9 GOl W OWRMT @Rd @ Wl gold
faerel o1 Sem O WA @ ARIM W ST B, Wefd
BIc @AMNR HAeM KU AR FEM W PR $W © |
el 2

e YWCEIU U g fdarR & W ad 2| s 9wy, 9
Ud fI9me W AFGYH 3R FlE oFl THE aNd B |
WEMR AN, O WU g9 8, WM iR dRds wR
R fRvg Wae &R Favel gN R 999 & forg
= @l 4 a8 2| U gfed-, WRd
WHR S Tdh 90 UBd o, MIHI S WAy @AUR
& faom & forv ve uRRufdel 93 @ fFEv oA 2|

wreaw Aifcdl $1 I gRT GIR AT W1 2| 39 oAl @
d8d, 9Rd H AU WU faFaMe 3R &R A, Yuid oM
4 g, o & Won MR & SWR & d9M I §hd
e 9 Wes W @xd gl (d99Re

http:/ /startupindia.in)

e ECECEEE
§

89 IR P — F&T 12



SerefierdT e

Tfafafer 1
W a9l
Ta1 &1 fovg & — T Sedl Uer 6?1 © dfcd 99T R
ATTH AT

N |
BN I g «@¢ — @ & fau e
& fou te Sed sRT o 2

Tfafafer 2

I
Tog
e
572

29 Tl ¥ g1 Sfal ok Aued el |l & I ugE &R SR BN |

fder

1. FE A yAe Ul UH TR BNl 39 UBR, AR UM dem H WUR
T E |

2. UG WE TP M Bl JOR Afdd B BT IAMWMHR M| A W
A W FW, V@l Uk Al S Ud SR oAl dedl § 98 Udb 9ed
@ B AR TE R ¥ §u @ SO B 2 98 doR B &R
TN ok el § ofbd TR U o9 2l gafon, afy o aflm @
WE Bl SR U @, O G 9 @A qOR @ [y 99 W U S|

3. REd A3 ANR el ARl & IR H 91d | Idd T8 B
I8 FHE o ARy fb w1 98 fdd Ue SEdl A1 ANl dRA
el fed 2 |

4, FE D IR TH SEMl SR AU BRA Al Afdd @ 9 iR W
e N |

5. J8 uRRerferr |

(@) Y| e Tl fambar € O dad fdd aferd 90 2

(@) T Th @@ R FUR FA 7 ol QU 12 H 5 qA D
49 o faaRa awar g

) RS T WHCRR FUH H AR 2|

(@) 9 e Ta A UG o s 2

(€) W H TH AWM BE T Ol IS AMRDI b oy e
arferd @l g |

=

90



®. 9 ddfcqd T
1. 9o U6 $Usl HREH ¥ Uh goll & A ¥ U ARt @

BIRTET TRA B AT TB o gl
(@) SeH (@) TG BRA qTT A
() AT (2) sregErer sifes
2. YA W & oW oM &XaT 8, Wl U @UNI & | WA TP ...
............... gl
(@) Serl (@) AT B aTen Afda
(M) BT HfdD () =Ty
3. Rfg & d@EE ol @ #fdd § IR & IS U FH A
GiRgA W HEel ol 81 RE T gl
() Se (@) TG BRA qT A
g, 9§ ddfeqd T

1. 99 Sl b1 M qdsU el U U PR § IR 3
99 Ifdd & IR H T TIN bR B

399 D [ N & 915, 3T IT I A T Bl
o TP SEH B U B IRAT V|
o Sufar @ g

o1 IR P — F&T 12



L G O

ﬂ;*‘hﬁh

SerefierdT e

AR R AT B 6 SEw ddM @
JENST BT FGEAT Pl TS Gbdl 27 I
gd W AR TA W Ul B
WEHq T BN b Whedl @I N8
T TSl B A 98 M Bl B
JEW € W fed @ STwiidd @
AHA | AT [T FeH TG IRY T |

STMI BT AHA PR dlell FI9 dol RN H 9 Td qIiRoNy
FREG T| TR BRE BHs 8 Gbd 8| ofdd Fed A AN
¥ f=faRaa e g1

o T GORFl A Bl W bl Bl

o T HAEBI B IR IuAm

o MATE WY SR 3T RIS WREAT @ Bl

o T W AfGH FEEEN B ST

ST & IR H O o9 9 TR IR ¥ Ol aRE W eud
IRD T dEmRl B W W R fERm W1 wear g WU,
qOR A SR WReh ANGYA VY @RIl Bl ¥ PR H Aeq
B Ghd T |

ag WM o Sufl @ (O @ e 4 We] & @ folg
YR WHR g IIOHG ody s 2|

T W QY ©

0?7?3?77557W—https://mudralsans.in/

o BfeC TRS AT — https://www.cgtmse.in/
oS Y 3'%?1'[ Qo — https://www.standupmitra.in/

“Th A b o1 T ed e th gooT g

W ST T Whd AR UET ARdl Bl offed I @y Afdd er
AT T T T, A SO SRIIGdT @ RYfy YT 8 Addl B
deg dd Ugdd Bl A B W Aldd B Uh Ghel AUR A H
fodl & 4T S H Ao Mol @ ok SHY S & dfdd @l
IR fe AgTd exd & fov IR @xar #)

92



FfdTd EII?JIIQ' Personal barriers

EpEETECE
wwwmmmww

§ A9 Ghar 2
3O e WR

R
I

[2

:
:
£
E
. Wo
:
k

AH—HqE 9 M & g T GE W

Afdd ge W Wag dX ol & 3R
WRINT ET BT R |

Wﬁ%www

ﬁm@ﬁ%m|

X HeX{Xd o i e o

IR Al Bl od 8

Eﬁ g & Wd f ASS PXa

T%’
qsu

B
1311
Wmmﬁ$w

%Q

ﬁ

mm

b=

m

B3 T

AR T — B 12

93



SerefierdT e

STl @ WY AechR
NMITH AR

Alcgd, U anfe
fehar

39 T # g v SEHl @f 99 WHRT & IR § 9dNd ol el

B FOR H GEAT BRAT U & 2|

forder

1. 909 &3 ¥ Uh S @i |

2. UM UG, o & Ffdd B AUR Y& dxA B AR bY A iR
fed @1 {981 BSARAT BT AHAT BT ST |

3. IOl Alcgd H TR Al B |

wfeifafer 2

39 AR ¥ g9 SUfal & aR ¥ R SXd 8, 59 aR H [ |

ferder

1. B SUfl & W S aell dEmi & 9R H W B oW, &
YW T I WA § 6 e e euT amweie S gw

FNd & oal B8 fhd 919 @1 X B 2|

2. Uh N H I3

3. BFW @ Uh e of R ford 6 99 omu Sem ge dxd ¢
HF W IR IR AP Fhdl g fIe W U 9 T ford |

4, Fha b dg H W fFed |

5 U3¢ Afdd e fue SO &R &l @& S @ e fix, @en
T e & 999 RS9 Jdfdd & X Bl GHEE e @
BIRET | A @fdd 3@ g w T IH 99T AEdl ©

6. ¥ & W U6 N & IR H 9T gRea &1 gy, W
BEl B & T d 9 Bl I gQMT AMRY | 9
P8 foll @ HEF WIS aR W B A I g6 el aIey|

94



F. B A Rl &1 fam o @ ok ¥ &
Rerfar KE
®) AR A Uh BIE SORMT RR ¥H A1 | (i) I
Wgl 98 PUS d9dl B
Q) e AU Whel H AD AN Y& A aArsdl | (i) ARGA
g e Redt o1 fFga o Rea & & g
) Y BT BRE BT AHE S99 B AR 2| 8 | (i) S
TUh U1 R Wiodl aedl & o feve &
AHA & A-F $US A ok I O 94 Y
fmdr 2|

g, 9§ ddfeqd T

TgaH AR Te Rufd H 971 @ yeR @ Raaw @ ke 719 )

SC IR

1. W @ AAT © fb 99 98 UM ANR Y& Nl & ol 99D
TN W B W BM XA B GHAT el B 98 o 9Em @
AT TR TE & TE oo g
(@) oot oM<t FReA

)

—~
~—

IRgT oI T

2. WS WMdl € f& 98 R AUR HRAT dRAT T, dAfpT IS el
WA 6 S8 T @ fov S9 R $eW SO B | SW e
TTEAT AR o g

(®) |81 <M &1 T g

(@) I B B

(1) SIRgH o

3. BT Bl YR H BlefHl B SRER | 98 el & o0 Bl

=

o1 fRld g% o)A ARl € offdd ¥E T8 Wl b 9 g8
ﬁﬁmﬁlwmwwwmwéw .................... gl
() 3TcH—

(@)mwa%?ﬁr

(M) 981 oo omsfear &1 °9s e

3T D QBN B 918, AT Ig IR | T Bl
e Uh ITHl 999 A Fefd awrmel o MBIl @ Ugd™ &Rl |

9 IR P — F&T 12



SerefierdT e

AN [ ST T © SR B R
J DY JAT 27 AT T @ wEEl

#

#2394 S
%aﬁiﬁ%iﬁ
p
=

)
2 3
P
2341
g g 3
el
%/Low

Gl BT TH W T DTN D
U I JBEH AR T W AUR| S HHEH]
B a1 50 T G B IA G ol

!

A
E
%
.
5512
z
4
e 3

-k =k
sl S
(_%/ :

g
5349

TR I AR & WIE b A
el E, g d Uh—g W AT T | olfeh
ERECRIC AR NG

T far ar fl 3R W e e W AT U Rl
A T BN AR ZH AU Aledd H ford |

e gicapn fedl 9 & a8 H G I qEqd B) @l Ud
W g| I8 FORAD I THRIAD, 6T AT R & Gl g | &
Ul & FHRAS gredHv & N H A |

UG Sl B I WO del Afdd W R BT B WO dRe
qel Af BT TH FM AT USdl © IR BUN P RIAT qE B
gedl 2| AfbT SEdl oo e W dEdar € R e @Nal g
JTH F BId Vb M b IR H AEdl 2, dfcd Th HHAR] B DI
IR B B o & fov amawwe e™ & IR ¥ ff Ao g

3
A4
g
< &
.74,
&

|

96



et @ @EM U @ 918, U6 GhA Sl §9M dldl gficanr fom 41 # Ry Mg g

7o
@RT 3V FHETIH
ok iR FIGTHE BT
Ugel Bl | FifesT el B g
T B Refa 77 @ v w5 ot
T 3R B B UF GEH g B s waT 7 see
Gl Gl ferg @ e ITIT Ve B G
ane? |
TRERE BRI e o A
0 3 T e
G i | -
fa7 41 : 9% Get @1 ghCHT
®. 9 ddfeqd T
1. BB GRd ed DI &AA, ol B TS BIOT Bl
HEAT T |
CIREY
(@) oIS DI
(m) g
2. TR & | ol Refd & o &9 @ el &
(@) TRERS  BIeTd
(@) Tga
(m) g
3@?‘[%@@%&@&%% ........................................... gl
(®) ATCTHD BIeTel
(@) TRERS DI
(m) e
Y. o 9
1. @ﬁﬁwwﬁﬁ?
2Wﬁwﬁmwwﬁ§?wwwaﬁw

AT URWRS B YSrEd fbar 2|

97 IR P — F&T 12



T il @ oEf @ SA geamt @ RN W wW W R
5 & Sl @ UM BT dIiRY| S= A § T3 alferdr |
fored |
U6 SeMl o | fiedt @ o
RT &
REIDESI] 98 Uh oRd dl o@d g 3R 39BN
AN ¥ 9 9% Uh ™
JPEH TH PR F DAAT I |
TEd
URERE DI
godl
TTGATHD DIl
I R HRaT?

T 99 3 I/ BM B 915, AT Ig BRA | Fe Bl
o 1 Ifcamil @ TEAH W A TE S B Ahd N 2

T 4 : ST e geTy

et ¥ # 7 S gfeant @ aR # G o v e @l
Ahel a9 & v aMqw@e g1 ¥e, T Ue Afdd g Sedl
gl oM & fou omawd ceael & aR H G| g
B T I DI AT T| FIF 42 U6 FHA STl § & forg

ATYH FdeR R IFgal bl <uar 2|




TR QAR $ G @ A GeW Ugd I8 WS @ A TS ol
f6 57 o €1 81 & U6 T 95 3R oo €| B W € b

e ® R ®m 8| & wafua avd § e I deEd ©
[AaR &A1 Hgcayl & 6 &9 auf § i & wy A

PH-HH TIR Wiad & IR § IEd gY T Ge Bl 9gd 3Ifd
g1 Ofg BH Tokil @xd ¢ ol 84 I8 e el ol § 3R
BT ol I} GEHd R®ifh AT TAd B T| 9 GG, TAR AU D
& IcdT § GE Pl G AR WG TedP 2| TR IR H FT D
S8 UM ARG a8 Gl g |

MY AT ol & W W el gRed & IR H G |

fAuigedl Decisiveness
o dr miee 3R @Rd AU o9 @ emar 2| Te Jfdd T Sud @
w0 H foige &9 99dr 2?

IS JeM Wi exd wg Fofwiiadr wew weayel favwar 99 o
Tl YT TP JIW B TEIH B R S W B IR B IR H T B
HTR FY IR BT AP &, M AR W, B B} & (o Gl G99 I7 &0
frifea ufmn & aeom @ fofg forr 1 9@ar & o fo fomo43 #
feamn a1 7|

4 g o
kD
=

3
;

BUIREDI
o)
& B A FIR B T B
IUBT UdT BT AIRY & U fow @m TE &o7 3R SAE BT YAl @MU W@ AR
AP T — MU WE B TAR B g H WEAY T |
T ATEd 8P AU b At @ Heg BT dRd &7
MY AU A IR ®T W & oA SAudT I R 9IT 2?
I Bl 87 I B B B folU AMUd U @ R €7
AT T FERRN Pl B PXA H 9T GG PR
Thd 87
" e A,

JIER Bl fageivor B T S G
SFTCl Dhed U IR @7 3egge del 2| DI IR TR & I IR & 918, 37
T I8 FM IXAT B, A T§ BH R BR? e foarR  uRdd #x Fdhd 2|

A IR AR @ 9%d B89 9 Jiftm faaR w1 B IR # o=y fuRt 9

Jb Aol 87 B G 91T 3 T I 22
Ted fdaR & a8 & @1 gred 27 AR @ T 999 b oI MU U drba
9 foor @ forv ufowmel @m 2° BT ST DA FA?

a3 43 : [7909% G @1 T

99 IR P — F&T 12



SerefierdT e

2
!

AP PR & SRl DA B T 3R
TS DI BRI N |

JFX foArdd USY B eRMBIC H AU TMa H
2| ST@ W T TE A d% Sa6 T A
Bld] UR §8 HR dre of| o Bl A gema
@ fodl Ty 4 99 WHar g1 T feell H AN
fegm| S weqa fear f& difeg @ or
98 IURT IR W6 ¥ T8 WK B [y 98} o
Pl b SAQ FEN A | TACNY, IV TR B
BT JAET Al YH PR fQdT AR AU T b
QT <l SR e UEE G A| @ AW o
TEqal W SFR b BRI B (AN TR FhHd o7 GAd U
U6 TR G |

ISRV . UEAM Bl AR — IR Bl USH™ gl fb 98 wER A
dife 99 wad &, 9Rr 8 9 U T H A4

i
%§%§
8 &
EE

=¥
53,

Faa¥
ELP

i
;

Hp
154

E

s st
B

Ugdl Initiative

100



ST 89 Tecd & R ¥ HEMI Ug, TR N & d1c dledl 3iR

TR el TN |

Rifce I8 IABI g oT| I8 AEA Rl 3R
@ | 9B 99 b ST9b UK 9l Bl WIsd BRA

ITF IR H R TP ANUN I DI B forv WM W &

A Wl & W Fgdl e fb Teed F U JEH YH B b folg
B Ugd dI| 3H WING HA & foly SH I dHeH IoM o, Iw
g o |

TRERG ﬁ"\’mlnterpersonal skills

TREIRE DI BT Fd B AR BT | el B ST Ig & AT <
W e Afdal & d9 BT Bl S OUGR, URWRE Bl BT e
I AN B WS PH PR B (ol IMIWS el I g

AU AR B Sflg H, BH EHIN AN W A @R
WY B GN @ Bl AR 99 H WAN HRA B AT Hel
WIS IR $T, B OWAR GERl @ A dradid a] W) g
S & forw F W R

ST Sigd @ A= &3 @ A @ W B exd & SAd
3R Fel Hedd & BRU d S9b O B BN Gdhd 8| U T H,
Th A9 § M PR Il AN T 8 Fhd B d AW oW

g, T 910 PR Whd 3 IR A I # favam o) dad g
e Th Se ok W @ dW @ TAe I B Th-gR
TG AAWGl FT FHM G AE@QOl 8 ol g |

gafery, Ife e AR B fF Pl U6 dwlRe ST fdeRid @
IR Y8R T, O Afd B bs A b WA BME AT Usdl 2| 39
YR, I8 HEd(Ol B WAl & b g AFl & W add vl 9 |
™ T P Y Wd 39 TBR ¢ |

g
Ll

5
f

&
3§

7

sgd

101 AR PrEt — FeT 12



)

SerefierdT e

o
-

Sy &
<
A
mp
4
&
sp
Z
3
g

| il
foereedl & 9 G 9 Afdd & W fawEe 9

{29

52449
552>
ot &

mwmmﬂquﬁmﬁmé|wmﬁ
BIedd HSﬂ%UlélmzﬁﬁﬁquﬁWWﬁ%
gafely, Ufifhar A & SRM WOREG qidh d dledl Ay
g1 AT S 3BT aX &l €, 39 dR # 9 o
dJedr T f6 o8 A

g 3R R I8 Ioolg & EGEN
Hhal & U9 WM A, U @WEAN B 6 gEe @fdld s @ W

T gg o WA A BT g ufdfhar ardiemy ¥ el — QAN
P A WA © |

102



W TR VA B A Tel U § q@ifh MU |
J f& MU HAT YIH BN AMNG g9 AT
B TG FE A B FH-FH T dfdd 3
PRI FHI T H A axal §| i T
M XA I A= Afddd 9l A 8 I8 W @ forg

T o) Woal 2] V9 AMdl ¥ 99 b1 Teud 9 B
WReY 3R FAM & [y AB@YU B Wl 8| 9 YT o
9 e @ o el o defifd oxar g, dfe W, eRHS
AR A wEgE e S W |

W by RN § MY Af d99 ¥ Mued g1 ST 9 $B 34
TR 8|

1. YTl UNGTI § FBABEH! Bl
2. ARING TR HRAT o oA, 3 |
3. BN W o BT AR Bl

4. S IT AN BT ARG YA

qGdl Perseverance

BY B @ [0 TN TG B GEAT GedT BTN © Wl &
qRFd 8| MY BA 36 IR H A4 D FEE B ARTH W
gl

5

_itL
1293

TETE H Ud A% SHl B B 20 A Tf%f%
U T AqUG TH BT BT AT U A ',
I SHM @l B hgAl fbar| SET A fd w@ifd
3 ghaal Al 8, s¥fely a8 Ma H 1 S el @
AR B SHM @le |

YOI H, HB AN SHd WR b hUs GAM A, el
Pel 5 9% 96 wRA ® ou T8 We o 4 aed 9 4
fafera sk =@l T =Ed o |

MG R 721 8o | S9 s/ Werdl ¥ AEd B bae fhar| I
YR H AU TR Bl R BUS §9 U AR TH WY fmar @
FTG U b FUS TRIG| I AU GHM b de” gReR Al
oI, 1% RN &1 W@Rd 7eqd ol |

J:I/
(3
é
A
3§
5
<

i

74

103

AR T — B 12



Semefierar e

Wal § T o Gl g

BfeT IRRAfY 8 W R & FHl =IiRU
AT I IR B folU B IR T 2

INTHEdR Bl ATy FRAT AR S ARG

faF 45 : 3T &7 [/

HISHIHD DI Organisational skills

SIS DT [hdl & dedl & U B & oy T 9, ol
IR GOEEl BT SETH SUINT BRd B gEdT Bl Gefld ded &) 39
ATSAIcAd HIW H 98k §99 9 Ud SeMl & I%c 8+ ¥ Ag
ferfl | a1 amey g9 e forv 9 vl b1 W BN | HIeHcd
e § fy=forRaa e 2

T Y§EH Time management

g yeee fame wfofdftdl ® @9 foy W 9w @ Fud g
B GO T 3R IR T BN DI UhAT g1 I Th GAd
FT DI TWE I ST PXA Bl eHaT B 9T UseH W fAEfaRad
i )

1. W TS W Yo g9

2. d&g iR &=

3. W FUiRd e

4.Th CM H o ANl B Agaqul dR1 fTHQIRAT <

5. 99 HEAQUl PRI FT Ugel Ao




S|
&
g

7
il

fArerelT
EIN

U HRd B gAY g faEm

e T 9 uRd & I g
| ' W e @ fog URA aRar @

&
3R
R

e
B e TN PR B &1 Ue

:
8
£
v
i
£
E
1
&

F & %o \WW§Wﬁ
mmm| ep EES
FEE eEEE
ﬁmw Wmmm%$
W$W W@m$w e
m%wﬁ @ﬁmﬁ ﬁw
s E
EEBEE WWﬁaWWm

AR T — B 12

105

g W I G el BUS Aol TRIQ| I/H D! IuE]
& HUS WIS Al ST6 IEE S0 [y Agaqul |

Th AMR H A B YSREE wx & § RS @
Yo foy O R Sarel @ WaRlt @ fov Sopedr @ 1@

qHd WUT BRAT RSBl IERE IRAT| o9 AR I
& PRU U Y G FeH AgaqUl TR 99 I § |

ggd oIl B dl & o Safed BN 9 SRl @ ave
A @ P H 9 9= Te WHE fAbdl ¥ dUs WIS,



SerefierdT e

Tfafafer 1
q o9 g
S AR
A, U afe
fshar

e 3 MMM § &0 910 FET & T AU IR H I B 8|
R W TR

IR NG x4 A T8 fod, IS BE B U6 Ifdd & IR A
AT 3R ST T AT BT ©, Od R § BE @ ol & b 98
I TE W TEAT 8] Uh IR BE & A9 H 99 Ifdd $ [T, T Ul

e

T U N O AT & Afddd DI BT W OURA Il o | I Afed

® gucel, T, &7 e & Webell & |

e

1. 3 b WA H UE Ful 9 |

2. Yd Afdd Wl G AR E, IqG WY FeN b WET A 8|

3. YRS Afdd SO g @ SN N R g @ 9w @er gy
ST S A B TWE M A BN AR FE B T H U Al
BN | SR & fofg, AR e e A @ S A d wu A
YIdl & Off 90 WeW D] TRg W OfMdl © dl 98 (Ul gucel
Ter, et @ e @ B AR W @ e § U Hw| J g
gl BT SEN S WA W) 9 8| 98 9 WA DI 8| 9B WD
GRS 9ol ¥, offe &% @fed & UM GE & URay oF 7g o e E

goT - U T TH-gE Bl A B (U AA W G I 8| g,

I @ 9T Uh-—oWR B G HEdqUl @ Ol g |

Tfifafer 2

W I

amRe far

CICRICARICIDR

g, U Mfe

39 T A g O A ol 9wl Bl 8 R @ folu
ARG IRt & T AT S0 |

focr

1. IR & FYg 9 |

2. fodl O @fdm @ i @ IR A o e e ufy WeR vad
2 3R ST o 9ERm 2

3. 39 THWRN & WM U9 @ &R S fAefolRad aiferer H ford |

106



fdd fewofy
ORI
TTIT B 8 R d o0 fdaR

4. 39, AU YED § F b BT GHI M T 2| S9 AWl ¥ I
™ e R am e 9w axd € 9% S g e & T
drferer WX |
AT BT A

T BT I§ T 27

T W fIOR J IMUD! THIT BT G {HAT S Aol
g ® W AOR @ R 9 & folv amue U
g 87

T Pl3 AR & W1 3MTH THAT I & PX & 87
J R R T 87

5. 30 WEd W fiel ol & 4 fagrR & o | W@ T R @
U3 B Sl D YED b [ofU HEFH B |

6. AMUd UM Hige dhd B ford Y MUSI 3 Y[R @I

AhAdgad Hed v H Aeg wnlﬁwﬁv@lﬁﬁﬁw
wfafafer 3 .

e IR )

TR Al H W D 38! Aol Gl |

CICRICAICID D

Alcg®, WA, T & oy B TRE |9HEH, o |

gicham

. 39 TCRE H 8 We awgel 4 SWE oy § © |

o d T

B UG & W8 H BM BT | UAd GHE DI AU W H IR D WY
4 U g3 Ul aegell @ o g

3 i T W A AR R PR T T W

fadar

1. 0 MU B U B U TRl W MR | M T gRT @Y Y
3gcH &l 8 W X9 |

2. A B FHY! IMUBI YU AGSH Bl AU A Bl H Bl oAl
BT |

3. UG CM & U SUIR( 9% M @ fofy JUd UM 35, 15 A
B G 2|

107 AR PrEt — FeT 12



SerefierdT e

4 T W & 98, YA <M B A QU MY WAl & MR W HeEm W
Ugel fodfl avg @I WA B} @ fou & fEe &1 W Mo e,
I TH T I W AR DI AHAAYED A B |
o AUD A Ao @ oA
. U9 UGl TN Bl o ST AT AR SAURI G BT T Al

e foar T 1 Sud HE I
o A PR Bl AHATYID DY [T fbAT AR TR T o7
Tfafafe 4

Uh A g gl

HMaeIS AR

Ay, U Mfe

qishar

« 9 TMMAR # &9 U9 § a1 X R TS G Bl dgR Aldd ae
d Heg PN |
focr
1. Pe H By VT JAfdd @iol ol AMUPT 3 Rg A ol ol |
2.9/, U 91 ford fb &MU I=T o6l e oxd W <@ &l (R, & 3R
g forg < 5 omuedr @ ar § 6 9 8RB} G R
3. 39, YD T Th TN & AT, Vh-Td G<d Al o |
4, AR BT [ FR G AU MU u uE AT 2
Tfafafer 5

JTT UM NG TG @ IR W 9 BRd § SR
U6 6 e 2

| 4T o SR Ul W g0 gY o fiee faang|

Gl @ 418, MU FNG & Uh ghs W U qAEuUl HaAl
W | I AUB FeT, SN, R AT R 3R AW b IR H
g

BSEal|
3.9 @ I W TP g §AN |
4, 39 Uh Fhd H el PN AR UR Y T W&l B Uh TR W B
3| R W g — Hor aml
5.3, JA$ Afdd foll R @1 T I SIS AR SH e § U |
39 A ¥ IR IRWRE PRI BT YA B

108



Tfafafer 6 fewult
NGRS
OGH — See U fAe
ARG ARl
Alegd, U anfe
gfshar

39 Tl ¥ g9 <@d € & e U fiee | &9 fd o @) Wad g

fader

1. 08cl YRS @ foY, & 99 SR IR o R wE & W TN

2. 99 AN B U A GOR X, W AT A ol A A [T DR

99 W T @ forv omue 9w Ue e g

3. UZcl WSS H MU AT S alell avqell @ G B 0T Y |

4, QA SR @ folg, Ul W & PG W U g ford | gHREd

N & I8 &1 UT SR B gom A e T SareRv, Ife S

RGS 14 Uh SH & Y H 10 3geH fo@ o @ W8S 2 & forg

15 3geH B e (EiRG & &1 T a |

5. 39, U& e H il Wl Aol ford | g% a!

6. TSe 1 IR LS 2 H @ AR A7

7. @1 A A NGE H A0S RS axd H W o7 Il B, Al A&l
wfafafy 7

ar
i

W ST X7
ARG ARl
Aledd, U anfe
wfehar

. JE BE R @ & IRd SEMl P @ fow T W w
Tfafafr s |

frcer

1. fy=faRad AUEST W 09 3MT @& e & (1. 999 ®A, 5 . 994
3 |

. URERE Bl

. foig o

109 AR PrEt — FeT 12



SerefierdT e

3. 3O DR U T |

e 511 : U TN $B IeHIleldl I9AT T IMUD U BRIA W HH
Co i B GRu G B

e 1218 : MU 3 I H 2! MUS B YT & W ITI AW & ol
7B W W § R WA FE F T

e 19-25: 30 USd W B I & I YO W M exd B |

4. O RAET R U IRG DI ST UG B AR, AU Rigd W 3 W
B |

% RfRl a1 39 yoR @ gfcam & fa] o w6 Sed 3@ o
qHd
TR

(®) MR 15 | F TH SeMl & S0 AUR &I U | (i) Mogean
AT &, Tl ST W M B el AN U B
R GfAfhar o 3R @UR & foly U faarl &I =
o G folv ¥ £
(@) o T6 fASR @ EM I® Bl aRdl ¢ TRES
® HO A G A D 96, 99 Ul Easll
Pl W WRARS Moy el d9dl B | I8
g5 Mo M &1 B ddl ¢ |

Uh [Wd [dpd @ANR ©| Udb (o, (iii) TR

:

P
(&) SR 3O M H U Al HS Agdel AT FH | (iv) gl
gTeiich, T8 caral

I B DY D

&
EIR
®B ANl W A A
3

9O
© .

fbaT Heaqul 2|

. @ 9, AU A & (b My fhe 9l §
J g AR fow W R A o dadr 2|
T 5 oM B PR IR FaHd 87 dF WO oy

110



3
[ 3

<67

:

i2
EEEP

E

15

E

TEATU | SETENT]

T5

g

“TEEEEFFE £ ET
FEletie B
ﬁﬁWWwwwmw ¢ WW
2 _
WWWWWWWﬁ$ww o~ E
mﬁmmmwﬁmmmm Wmm
mmwﬁmew e
wwammmm 5 BT
s ELE ERREEEEES



!

112

I'M READY

.IT.-% n H g
il o
GREEMN JOBS: NOW 3

i — —

g URA @ fog W AR I WM | 9 @1 SWN

Cagll
WH UM 3R @R SN U g ¥ SINORS YSUDI Dl
T FRd |

N ST @ Iclfed ax4 @ folv &9 WiaRe # IS
W Ghd & TH W GIRT B M IR I T
Px1 A Age axdl 2| ¥ e fedll ft a3 o sEm
%) # & Whd § — UNURG HACR, SN HIYHERT
IR FERH AR U R O TANERNT FHofl |

I ST @ SAET R WUd @ WA wY W SRd
G M AR AR YEREIT PR H HEE hed dlel B
o B0 H gRAING o oar 21 ¥ 9 &l § 8 Wed &
— Foll, 9l WA RV, SURTE  YEEd iR Ugyul
BRENE

IR BT WA PR T GBI bR H Hedql TG
B T W8 &, 9l GHRgd A REE 8 9a6d &, ®ifd
g AMT IR W Wial W9 feum S # |

T PRk PIfd 9 B & O JATRAT & YR Faell

8ol # BRRG B g M PRSIl # UIGR  Ifie

2 fo M9 fafeem anfbeae, waiwor Aoear, smufine
T ! .

S %

%
3
%\
i
:
]
:

-2
§§% 14
P4 &
%‘_é o
a -

%
413



& wRifed fear o e g SeENY & fow, BRT SR | Uml

3 s 5 o
4 3
493

5

7

Sif

|

I

g
13
.
g%
a7

2,

1517

8

:

2 s1

%+ ¢

{

of

2
%@

Sp

WeR, ol dufal & W Adex ool WFeeal 981 @l T
STHIT TR ¥ ggad AN W1 YR E, Wrﬁ drs fiRa fou o1 w

WA &l 2| g TAABR0g Foll, Iad faarg iR Ul yeem
&g ¥ ol B e emdnt & fsm § aM a) W2

a7 ofd FRE AR ARE gof @ waEie deEd B To
SGAT W ARG & Ol [ e ¥ U YBR B ARl (Se) E,
Afb g I AT IRuRe Fawml ok Ue R i B 2

ERT PIvTd

113



114

gRd o1 green jobs & oM™

JdgaReN & BRA F (FF Sifed) U @URI B
FH I, T IR Bl [GHRT B AR BH ol
AN & UH 991 AR WA axd & | WIfaReT ol
I 3R PlET Befic B BH A H INEH o
el I ifed sForadl el B VP Aeaql M
Waad a9 W §| F ofed @ Aeg 9 A FE fa
g

ol AR @ed WA @ qear # 3fg |

AErSd 19 S $l H G |

AURTE SR Uguor W R
RReftd 3 @ e iR TR |

Sy URAE @ YTEl B R e |

3 # gRd 3 Green jobs in agriculture

Sfdd  aEmEEl SR WAl v Ul Uik § R
gRT &1 WOIRY & 3Fdd dud | UMl SR wHdl
B S Fhd & U9 AU MUaiE B AHT Sl
g ife ot @ e Peawmal &1 Suam =
fogr oM €1 ¥E S WU AR M & yguw
B AHAT T @ifd M F B3 WRA T8 Ao

=)

PN H AR I B B SR
faMl @ SAlfddT Bl Aolgd B
B AEHN AT weE yd W § ¥ U 2
39 Ulshar # feaml o UM wWR (A Rd W

[GaMl @ e 3R Th S dued
M SEd  WTeA (THUel) @ forv
& Pl e e 3| vedlel g
a1 dmia fREFl ¥ Yo geRid drel
gl

AR P — B 12



uRagd § 9 4 Green jobs in transportation

Suli-gd  dedl R ddfoud  Wefad W (WgAel) ol
Ipfeqd 399 @1 STANT YHESd 19 Idod B BH B H
7eg A 9l 8| Rd WeAR gRT 10 3R 2018 &l =fvd
T O o9 A0 A IO @ dtid ST ® U Ugd W
& dfed fbar T dIfe wE AR I mIRd wlewie
M W A @ SUderdl H [uR @, geMia drenfifeal
@7 faerg 31 SR |EHsO & ol qRed & I H gl
DS FH| Vg N W U™ AT I WU IR,
JR-HA, e dAfed Sarfed ol o9 9 A9 Sife S
PR Thd B |

SOl HAl™ @ dgd ol EW?N?% afide  fafics
(EvaCe) T o Tolfdge T SR gw fea E o

@ag@rﬁrwaﬁzﬁwfrmmmg@mﬁ
solfded Ao ofd &1 g9 Sollded aed WENfGAl &l S
S 39 (STERY @ foly, -39 ERfse sofiesd aes, @
foagd) & 9 ERM T W 8 Wefh §% N ddd
U6 dedl (X goifdg® ) @ A 9 fOutell @1 SUERT
F 2| ARG TEd 399 @ f[dbd $ WY H Ioldgd $Isd
@ Jgd ¥ AR BT dNR H AU YAEIHI & foly SfaER el
g -ReEm @ Woed R wRwe § Safal ¢ @i
g ¥ oRaed &7 § 3R e IR i wed §)

ERT PIvTd

115



116

W e § WM W4 Green jobs in water
conservation

T B B oM H ff Weg R IAhAT T
fosTell & do™ el U & SO WIEfhd g™ el O

BT ST fhar o @1 g1 U faorell &1 SR T2
g 3R AN BT AR-E FRA B b dNIbT YSH IR @ |

99 WS W § Al 39 WG & wU H el HoSen o
qHAT 2

R 3R ygq ol § ERT $ Green jobs in solar and

wind energy

AR R g Full G W ol USH A 2] Th IR
BIcHlfccd IR BRI, MR el a1 9f 4 GR 0
Wifid exdl & 3R RE aRaT ¥ TS Wk agfed
THRRE A= YeR & Wk Bicdlifecd 8  oflgieT
ReH 3R ¥ dged @I 3Ridd, o 3R RRR wvar 2|
39 83 W §P MM AIGRIT § wwely, AR U eIl
TR IR &7 THIRI |

E_CFT—E;RW | Eﬁﬁ PR Green jobs in eco-tourism

ZPI-CRA T S ANRRT & FORET & WRE0, TR I
BH B, MHIAD TR Bl GG AR UG Bl HH HA
@ Hecd Dbl THIH B U U T UM BRAT Bl e
TG Bfd @I 98k g9 § AeS deal @ HMife A
QIR & IhA WM W FH & IR H IFTSI HEGH PN
gl 3@ cRA H# BRI el H @ R TS AR ZA
R sifaver wfia €|

AR P — B 12



¥qq 3R A § gRG ®™ Green jobs in building and

construction

ITHA
maﬁsﬁ'\f‘sﬁﬁﬁalcwao‘rqw a8l I9 fifes feomes #
Tdievei AR R-Adeei W @ I @ foy e Teigd

YSH fbdr Sl ©1 I8 Hewqu © fd Ifyd uRewr 4bikd
Wﬂﬁﬁﬂﬂﬁﬁﬁﬂﬂﬁiﬁﬁ?qﬁwzﬁiﬁﬁww
g0 S &R Wﬁaﬁwaﬂ?ﬁﬂﬁﬁzﬁﬂmwﬁaaﬁwlgﬁa
T & e
e 2
GlCEEH

B 93MAT o7 B U DA b @ BRI
| IT AGWD & b SUYH DU H o Wd HHG Bl
foar o W fb& 99 ffesr &1 g8 WM W
mﬁﬁmwélw%ﬁtﬁﬁaﬁmiﬁmﬁﬁﬁw
UREYY, aETarl, NG gCHl B YEREME, T JeEH NS AHA © |

SN URMC UM # 8Rd &1 Green jobs in solid waste
management

O/ JURTE B ONe| IHEAL AUR Dal, IS o™, e,
Bd MU o 3T & w9 § uRwifd fear mam g

IRA WHR & I o™ 9 7 o ulRre & ARy ok
TR & N @ AMR W 14 HPE # ffea fear g s wa,
TRuIfere!, afoiig®, enfiis, ARG, HoRT, NG, I W d%ls,
Td U, AT 3R AR Heldl, AR, WeRe 3R Aol Ul |

39 QMURTe UEud YUl W WUR, 3felTd, URdEH, UHRRU 3R
HR BT FUeH WA B PO YeEH W G WE Sied -panT
i, S Iulde ydyH, Uit ¥ ®HI, SMUfe o U,
e Ao anfe o e § g

SYd qdid W BRd P Green jobs in appropriate
technology

SWYA qhbild Bl TR B AbId & ol WRT & Fhd ©
AR W MaRIGaRl & 3fhd ol Sued UrEifial & IS0
G alferd AT T W Tod dd UMl b UU, e dke § AR
du, AR WA e B AT W WA qod © oy I WU
W SUAY GERAl & A WY 3 hd aud | BM har o
qhal g SUgH dddd H UM Sl H EnN  Sded, od
SUAR B, Wd ARV, 99 Wl 9, &eedl, Yer], @l
ScTed, Wi, e i & wfie 8 |ed © |

ERT PIvTd

gRT TR
TR FET
Ry
(mgars)
few, 3feae ¥iH
fafesT BT
(eeiiaRe) @
RITUAT 99 2001
LICIRIEDI
CIFVIEISIICEIY
YT PRl 8,
o =5 M=
fafos e
TR, THI0H
AT 3R =
fafesT ufreror
HRIHH fAHRid
AT M 2 |

117



W T4

pIEASIC

IR LI PRI

U, URYe e

gishar
o U4 W H SURYT BHEI & & & AWR W Y8 & |
o UG B Udh UM Sfed &I qUF S Sl 98 Gl aredl
TS W UG UG gd I R 9w & A

B S W UG AR wE fde |
@1 el 980 dR MR Tsdl §] S9 & WM 9ol 3R
Aar

5 v st

R ff e ST aRd ®
X I ST ST g9

4949

(5) 9%
g Y SR T
fy=faRaa ez # foell o <7 eRa & &1 AW IaRY|
(i) fmfor
(ii) FAERONT Folt

399 B [ N @ 91G, MY IE G A Fed Bl
o fff SEI OR &= § W9 Sfsg & uga™ BT |

AR P — B 12

118



I W ? f6 AeRal @ 9 gRa er a1 W Wi dEr O ©
Sq S el W M AR dlel ARl Yiddhe  YARYT el yWiEl @l
FH XA H FEE BRd B, IR TITRV, e AR WG WU A
Wl SEMl R rfaRenst @f 99 ¥ ASE aRd @ |

fesy 19 SuiM gas emissions & ¥ &

TERd Nl H W HB FEA SRS, HIoF, ARgd JieIgs,

AN 3R FARI TR B (AUB) ©| Sded §99 @ ol

qEl 3R MpoRe BT SWINT R4 IR F QRN B R/ oA

SR I ST B OEl A N gl et arell

q NG T

, o991 Teliga @ 8 2 |
AT

i‘fl%’
£
i
g
%L

far SU| s FeRT YeEd H Weg Ao
fafmior dofsi ok eREMl # ydud Ul @& & WO H
IR B A D BH PR D o (AN WD G B
Rd | I8 HY WD g T |
Y AT Hare AT ST G STIRT AT
SRRV & folg, YR Al H afiRd Ad Bl IR dRd @
oA H 909 Al Sl g, i, S b A H Wil Sl
7| wicd awgell @ T #§ sfe-e R Wy @ AU Il
q R 9 wifa & T g
e UTq<T BLEL quality control Cagll
I IR ® I A Il g, T SdIgd BN AT
A dlel Gl W OFH BRI, 39 Waﬁwmw
BN | 3 Walfeld fRRFT SUeRvT &1 W fHar o1 j@ €, S
URME Al H IR Gl UgAM @Xd H AGE @X
qHd B

NG|
YR,
P

bl

ERT PIvTd

119



120

o JURe faf9 Waste exchange
39 ME UH AT F IURNE IR GEY oy de
STl 2| 98 T SWN 3 AR W Ui fued @ &
N BT JAFRT BT 2|

. g—w ®I Y99 Managing e-waste
B 90 dddldl $ W, R AEgA B, duciy iR
de O AR ded 3—hoR b Yeud § Al THRel b1 e
g PR b TS & foU Gaq faem R AT I G
EAY |

. WRT B el ARl BT SWINT Use o eco-friendly material
Jgitel | faf= MRl B @ B g, W QR & e
SAERV & foly, el @ W SR TR wic anfe o oMMl ¥ s
BT Ghl &1 F= AN W SUE BT T ARy R $Hd
ST B WicAfed &R Bl MaeIHar ¢ |

uiRReIfie 3 @1 ver 3R E_"I_\‘Qﬁ'q:l Protecting and restoring ecosystems
TRRefe o3 Sifdd ik IR-Sifed widRl &1 ¥e[ 8 &I U 9™
ANE € R TH SW @ 9 ddd R §ERN avd @l I8 Wel
AgeM © W8l & UGld 99 Wadl & | AMdE Tk o 6 ush &l
Aed dery W TRRIRSG &3 &1 e 8 wadr & MY Seary
IRacE 3R WPpfaed IMUQN & Wadl & foraw Sifad witml &1 Shfed
Al qRGd B O g

AT AT UIRRYIfS 3 & WRE SR Wiplad FHEMl &1 ST
BRI gU AAHHG Bl GBI I H AGE I B [ FM IR R B
T 3R T A B ReR &R § WeE axd &, 3R SO, I
@ S @1 B % ©| AW We B ERT evd § weg @
|l 5l N B Bled H T, AUG W ARG Us oM, JaT W@Re
AR R § Faer &1 9 dered 4 & Soaed b MR e
ST Hehdl B |
vicldlg URaqH & Wl @ UMD Adapting to the effects of

climate change

e 9 gg a0 & IMR W Terary H uRadd B 9 & AN

P

i

e



YRA WHR A Tedr] URad R HItd @l W foed & fow
S 2008 H G SAdy GRacH BRI AGHT (TICGRIR) Bl s
@ TR H AR FHul & faRie 3l H ome frm e €
ol GET, AT, U, Wefarg URadd & o fEEerdt wiRRerfae
o, aivel, B 3R BRAfGe FM Bl 99Y XEE, | diered 4l
& I SR UIIRY, @, AN, W GEREAl 3R PN W Searyg
IRadH @ Ufdgd Wl & SFded @ il @ GaIftd dRdl g |

RS ST
Tfifafer 1
URER g1
ARG ARl
e IR, ViE U, R anfe |
fshar

o UPh T H AlE Fedl & G & MR W FYE 9910 |
o TRT FEI @ THR IHcal X 3R TH URe? 99| 30
[Qene™ @ A @ ¢ H Ud Yol &l M &y |

Tfafafer 2
GETRIYOT
A H AR
d, fedl, arl, e, anfe |
fshar
e TH UY &7 @ UgdM X gl MY Vb el ol 9dhd |
I UPR b UY B U qU RRrfe & W THGd dY off
AT WH W Y| IR0 & forg, o= iy & 9 o9
UMl @ ARG BRIl F1 36, Uh IUgAd dle A7 UERIAO]
B | Y AR SR AW FAN | GAREd @) fb qm gy
o (AT w7 9 Tl < RSB T AN |

ERT PIvTd

121



122

®. 9 ddfeqd Yo

A QU MU gl @ o W U SR WEl fddwed |
1. M@ M H Uh davl f§9 3 R I8 M aR W, & fod
g1 9 ARG R ST T SMUDI R BRAT AMRT?
() DT UdET DI Uh d91 97 oW B fIU ae
(ii) VP HAX B A DI BH A & SUF G AlMey
(iii) B TR BRI Bdl AR AW Al
(lvwﬁaﬁﬁaﬁaﬁﬁﬁmaﬁ
(33) , (i)
(@)u)(u)
() @, (i), ()
@ @, @)

2. Uh Wi Wagl ¥, 980 9N dd g o B 8| YeHS Bl
B3 TR Thg Mol @, e BN USdl &l Afdd Fax @l
DI BH IR Ghal 87

(®) 30 HErS! AT WY SR BT

(@) 3 oisfba Wge & 9w

() 39 e dlgd R N fUee™ @ folg ool

(@) 39 IR H§ ¥

4 S

..Wﬁﬁa@aﬁﬁﬁa@aﬁﬁmm ERT B S Ha
B FH I G ¢ |
2. YESd Wl & IO B BH PR W UM BRI & e

IE HYA A a9 B
. gﬁﬂzﬁﬁfaﬁﬁﬁﬂﬂaﬁ?%ﬂaﬁwlwaﬁl

AR P — B 12



TPIS 1 : YAR B
TH 1 : Wihg ®Y H G
1. (@) 2. (@) 3. () 4. (9)

Session 2 Parts of Speech
A. Multiple choice questions
1. (b) 2. (d) 3. (d)

B. Fill in the blanks

(@) The boy is running.
(b) The girls are skipping.
(c) The girl is riding.
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(f) The dog is barking.
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